DEVELOPING A SUPPLEMENTAL ARCHAEOLOGICAL METHODOLOGY:
A PHOTOGRAMMETRIC STUDY OF SHIPWRECKS
USING A LOW-COST ROV

by
Katherine Lovejoy Clevenger

September, 2017

Director of Thesis: Dr. Bradley Rodgers
Major Department: Program in Maritime Studies of Department of History

In recent years, photogrammetry has been increasingly used as a supplement to traditional archaeological mapping methods. This study aims to show that photogrammetry can be a viable supplement, and in some cases a replacement, for traditional mapping methods when water conditions do not allow for the utilization of standard mapping methods, such as extreme depths and high surge.

Additionally, this thesis presents a methodology for using low-cost equipment, in this case an Open-source Remotely Operated Vehicle (OpenROV) 2.8 equipped with GoPro Hero 4 Black cameras to capture high quality video footage of shipwrecks. The best possible resolution and frame rate speed of video footage for photogrammetric purposes is examined. This thesis utilizes numerous computer software, including Agisoft PhotoScan Professional Edition and Adobe Illustrator CC 2017, to create highly detailed 3D models and 2D site plans, respectively. The information provided in this thesis can be used as a guideline for recording submerged cultural heritage with this method. Finally, this thesis explores the use of this methodology to
improve management of shipwrecks and addresses the use of 3D models and video footage of
shipwrecks for public outreach purposes.
DEVELOPING A SUPPLEMENTAL ARCHAEOLOGICAL METHODOLOGY:

A PHOTOGRAMMETRIC STUDY OF SHIPWRECKS

USING A LOW-COST ROV

A Thesis

Presented to the Faculty of the Program in Maritime Studies of Department of History

East Carolina University

In Partial Fulfillment of the Requirements for the Degree

Master of Arts in Maritime Studies

by

Katherine Lovejoy Clevenger

September, 2017
DEVELOPING A SUPPLEMENTAL ARCHAEOLOGICAL METHODOLOGY:
A PHOTOGRAMMETRIC STUDY OF SHIPWRECKS
USING A LOW-COST ROV

By
Katherine Lovejoy Clevenger

APPROVED BY:

DIRECTOR OF THESIS: __________________________ (Bradley A. Rodgers, Ph.D.)

COMMITTEE MEMBER: __________________________ (Wade G. Dudley, Ph.D.)

COMMITTEE MEMBER: __________________________ (Jason T. Raupp, Ph.D.)

CHAIR OF THE DEPARTMENT OF HISTORY: __________________________ (Christopher Oakley, Ph.D.)

DEAN OF THE GRADUATE SCHOOL: __________________________ (Paul J. Gemperline, Ph.D.)
I would like to thank my parents for believing in me and providing support throughout my time in graduate school. Thanks also go to my sister and Melissa Price for helping me keep my sanity throughout the thesis-writing process.

My gratitude goes to Dr. Bradley Rodgers for his guidance and support. I would also like to express profound gratitude to Dr. Jason Raupp for his unwavering enthusiasm for this thesis and many thanks to my other committee member, Dr. Wade Dudley. Thank you also to Dr. Nathan Richards for remotely processing the *Portland* models on the Coastal Studies Institute’s “supercomputer” and the underwater archaeologists with NOAA’s Thunder Bay National Marine Sanctuary and the Wisconsin Historical Society. I would also like to extend gratitude to Dr. Thad Wasklewicz for his photogrammetry recommendations.
# Table of Contents

Acknowledgements ........................................................................................................ iv

List of Tables ...................................................................................................................... ix

List of Figures ..................................................................................................................... x

Abbreviations ..................................................................................................................... xiii

1 Introduction ....................................................................................................................... 1

1.1 Research Questions ..................................................................................................... 2

1.2 Review of Literature ................................................................................................. 3

1.3 Methods ....................................................................................................................... 4

1.4 Limitations .................................................................................................................. 10

1.5 Conclusion .................................................................................................................. 11

2 Case Studies .................................................................................................................. 12

2.1 Atlanta Shipwreck ..................................................................................................... 12

2.1.1 Historical Background ......................................................................................... 12

2.1.2 OpenROV 2.8 Test Flight ..................................................................................... 14

2.1.3 Results and Conclusions from Test ................................................................. 15

2.2 Montana Shipwreck .................................................................................................. 15

2.2.1 Historical Background ......................................................................................... 15

2.2.2 Customized OpenROV 2.8 Test Flight .............................................................. 19

2.2.3 Results and Conclusions from Test ................................................................. 19

2.3 Bullhead Point Shipwrecks ....................................................................................... 20
5 Discussion and Conclusion ................................................................. 83

5.1 Answering the Research Questions .................................................... 83

5.1.1 Can video footage of a shipwreck taken by low-cost action cameras
attached to a low-cost, small ROV be used to successfully create a
photogrammetric image of a shipwreck that is accurate enough to allow
archaeological interpretation and analysis? ............................................ 83

5.1.2 Can this practice decrease the amount of time, workforce, and expense
needed in the field to map a shipwreck? .................................................. 84

5.1.3 Is it possible to obtain detailed measurements of a shipwreck from the 3D
model and/or 2D site plan? .................................................................. 85

5.1.4 Can this methodology assist in the future management of
shipwrecks? If so, how can this data expand the public outreach component of
management? .................................................................................. 86

5.1.5 What are the advantages and limitations of this method? Are there options
to mitigate the limitations? ............................................................... 86

5.2 Significance of Study and Future Research ......................................... 88

5.3 Conclusion ..................................................................................... 89

References Cited ................................................................................ 91

Appendix A ......................................................................................... 97
LIST OF TABLES

Table 1. Computer specifications .................................................................42
Table 2. PhotoScan settings used for all 3D models created for this thesis........43
Table 3. *Portland* 2 frames per second ..........................................................65
Table 4. *Sinkentine* 1 frame per second ..........................................................68
List of Figures

Figure 1. Attachment of GoPro to a threaded rod of the OpenROV 2.8 ........................................7
Figure 2. OpenROV 2.8 modified with three GoPro Hero 4 Black Cameras........................................8
Figure 3. OpenROV 2.8 outfitted to capture profile view .................................................................9
Figure 4. Swim path followed to document the Gnalić wreck .........................................................10
Figure 5. Passengers on the deck of Atlanta circa 1895 ...............................................................13
Figure 6. Montana shortly after its launch in 1872 .......................................................................16
Figure 7. Site plan of Montana. No north arrow or scale provided by TBNMS ...............................18
Figure 8. Shoreline map of Bullhead Point with the location of the site’s shipwrecks .................20
Figure 9. Incomplete site plan of Portland. No north arrow or scale provided by recorder ........26
Figure 10. Path flown for profile data collection of Portland .........................................................28
Figure 11. Longitudinal flight path of Portland .............................................................................29
Figure 12. Transversal flight path of Portland ...............................................................................30
Figure 13. Modified OpenROV 2.8 collecting video footage of Sinkentine .................................32
Figure 14. Location of the “cut” tool used to crop video footage in Photoshop .....................36
Figure 15. Layers created by the “cut” tool in Photoshop ............................................................37
Figure 16. Location of the extract still photographs arrow in Photoshop ........................................38
Figure 17. Render video pane with appropriate settings selected in Photoshop .....................38
Figure 18. Importing bulk images into the Lightroom catalog ......................................................40
Figure 19. Correcting wide angle lens distortion in Lightroom .....................................................40
Figure 20. Synchronize settings to correct lens distortion for all images in Lightroom ..............41
Figure 21. “Align photos” process of Portland from 1080p60 resolution in PhotoScan ..........44
Figure 41. Point cloud analysis of the Portland 3D models using CloudCompare. The smaller yellow box marks the bounds of the 1080p60 model, while the larger one denotes the 4k30 model.68

Figure 42. Orthophoto of Sinkentine from 4k30 resolution.69

Figure 43. Orthophoto of Sinkentine from 1080p60 resolution.69

Figure 44. The shadows under Sinkentine’s frames might have caused problems with photo alignment.70

Figure 45. Comparison of Portland’s site plans created using different mapping techniques (A: photogrammetry, B: traditional mapping).72

Figure 46. Historical chart of Lake Huron from 1880 with the location of Portland illustrated by the red circle.74

Figure 47. The current location of Portland is visible on satellite imagery of the Besser Natural Area.75

Figure 48. Portland site plan overlaid on satellite imagery to illustrate the relation of the shipwreck to the shoreline.75

Figure 49. Zoomed in image of the 2007 Portland site plan illustrating ceiling planking and frames that were present at the time of recording.78

Figure 50. Zoomed in image of the 2017 Portland site plan illustrating missing ceiling planking and frames.78
Abbreviations

API Application Programming Interface
AUV Autonomous Underwater Vehicle
DIY Do-it-yourself
ECU East Carolina University
DSLR Digital Single-Lens Reflex
FOV Field-of-view
FPS Frames per second
GIF Graphics Interchange Format
HUD Head-up Display
ISI Inland Seas Institute
LED Light-Emitting Diode
NOAA National Oceanic and Atmospheric Administration
NPS National Park Service
NRHP National Register of Historic Places
OpenROV Open-source Remotely Operated Vehicle
ROV Remotely Operated Vehicle
TBNMS Thunder Bay National Marine Sanctuary
WHS Wisconsin Historical Society
1 Introduction

The intention of this thesis is to develop a supplemental archaeological methodology for creating three-dimensional (3D) photogrammetric models and two-dimensional (2D) site plans using low-cost equipment, video footage, and computer software. For this thesis, the term “low-cost” refers to a remotely operated vehicle (ROV) and cameras requiring less than $2,500 investment. Traditionally, standard underwater recording methodologies are baseline offset, which involves measuring a feature at a right angle from the baseline and recording the offset, and trilateration, which involves measuring three points relative to each other based on angles, thereby creating a triangle (Nautical Archaeological Society 2009:120-121). Data collected with these methodologies can be used to create shipwreck site plans, cross-section plans, and hull reconstructions, as well as to conduct analyses of wrecking events and material culture found on site. Photogrammetry is the art and science of producing accurate 3D measurements and descriptive information of an object from multiple images and has the potential to decrease time and expense spent in the field. It can be used to record in situ shipwrecks – wrecks still in place on the seafloor – and using low-cost equipment makes photogrammetry more accessible to a larger group of researchers. The systematic collection of photographs or video footage for this purpose, however, is highly dependent on surrounding conditions, such as visibility, current, and light.

Research data was collected with low-cost, compact, and rugged cameras designed for filming action while being immersed in it were adapted for use with a small, tethered ROV. Considering that environmental factors often present challenging conditions for a small ROV, shipwrecks in the Great Lakes were selected to test the potential for this methodology, as the
Great Lakes are typically a less dynamic environment than the open ocean. The shipwrecks of
the steamers *Atlanta* (launched 1891) and *Montana* (launched 1872), schooner *Portland*
(launched 1863), the converted barges *Empire State* (launched 1862), *Oak Leaf* (launched 1866),
and *Ida Corning* (launched 1881), as well as *Sinkentine*, a small fiberglass replica of a
shipwreck, serve as case studies. The case study sites located in the Great Lakes were selected
due to favorable conditions and accessible locations, and *Sinkentine* was used to test the ROV in
a controlled environment where techniques developed on earlier case studies could be
implemented in one setting.

1.1 Research Questions

This study aims to test low-cost equipment and a photogrammetric-based methodology to
determine if they can increase efficiency in the field and decrease expense and workforce, when
conditions allow. Therefore, this thesis addresses the following question: can video footage of a
shipwreck taken by low-cost action cameras attached to a low-cost ROV be used to successfully
create a photogrammetric model of a shipwreck that is accurate enough to allow archaeological
interpretation and analysis?

This thesis also explores the possibility of using this proposed methodology to improve
productivity and decrease cost in the field. Additionally, it examines the use of this methodology
to potentially improve the management of shipwrecks and further engage the public with
underwater cultural heritage. Therefore, this thesis addresses the following secondary questions:

1. Can this practice be employed to decrease the amount of time, workforce,
   and expense needed in the field to map a shipwreck?

2. Is it possible to obtain detailed measurements of a shipwreck from the
   3D model and/or 2D site plan?
3. Can this methodology assist in the future management of shipwrecks? If so, how can this data expand the public outreach component of management?

4. What are the advantages and limitations of this method? Are there options to mitigate the limitations?

1.2 Review of Literature

Numerous articles concerning photogrammetry and its use for archaeological research have been published, particularly during the last decade. Although first used underwater in the Mediterranean Sea by George Bass in the 1960s, photogrammetry has become a standard in underwater archaeological work in recent years (Bass 1970). For several decades, underwater photogrammetry was not frequently utilized and remained expensive and time-consuming to conduct. By the turn of the 21st century, however, its use grew rapidly within the field of archaeology through improvements in photogrammetry processing software and in computing hardware in general (Anderson 1982; Drap and Grussenmeyer 2000; Drap and Long 2001; Green et al. 2002; Drap et al. 2007).

The use of photogrammetry further increased after 2010 with the release of Agisoft PhotoScan, a multi-image photogrammetry software package that does not require as much light or visibility as earlier photogrammetry software nor the need for precalibration of cameras to create a 3D model (Skarlatos and Rova 2010; Diamanti et al. 2011; Drap 2012; Zhukovsky et al. 2013; McCarthy and Benjamin 2014). In the last several years, considerable effort has improved the accuracy and lessened the distortion of photogrammetric models (Bianco et al. 2012; Westoby et al. 2012; Balletti et al. 2015). Earlier studies indicated that the use of coded targets, printed markers placed on the site before photos are taken, increased the percentage of photo
alignment (Diamanti et al. 2013). This practice may not be necessary on all shipwrecks, however, especially those with numerous distinctive features or when using cameras capable of collecting higher quality photographs (Yamafune et al. 2016). Currently, photogrammetric data capture is generally conducted while diving with an underwater camera; photogrammetric ROV research has the potential to expand beyond depths attainable by SCUBA divers and perceived notions of cost effectiveness.

In the 1990s, archaeologists began experimenting with photogrammetry using images captured by underwater ROVs in order to reach shipwrecks located in deep water. Since that time several archaeologists have proven that photogrammetric models can be produced using data collected by expensive, digital single-lens reflex (DSLR) cameras attached to ROVs (Drap et al. 2007; Drap et al. 2015; Nornes et al. 2015). Additionally, autonomous underwater vehicles (AUV) have successfully gathered data for photogrammetry, but thus far have only been successful when deployed in environments with little bathymetric variation where the seafloor is relatively flat and free of obstructions (Gracias et al. 2013; Demesticha et al. 2014; Kwasnitschka et al. 2015).

1.3 Methods

The methodology employed for this research was separated into three phases: historical research, archaeological fieldwork, and post-processing of data. Primary and secondary historical sources pertaining to the selected case studies were consulted prior to beginning archaeological research. The Alpena County George N. Fletcher Public Library has a large repository of primary sources concerning the case study sites. In addition to the Alpena Public Library, Thunder Bay National Marine Sanctuary (TBNMS) Research Collection's Alpena News Collection and the Wisconsin Historical Society possess a number of primary documents.
Secondary sources concerning shipwrecks and salvage in the Great Lakes, United States (US) salvage law, and site formation processes were also consulted.

The ROV selected for this research is a product of California-based company OpenROV, which began production in 2011 with the aim of making underwater exploration and education affordable (Lam 2012). The company’s platform is completely open-source, meaning the original source code (i.e. the original form of a computer program before it is converted into a machine-readable code) is freely available and may be legally redistributed and modified, and uses the do-it-yourself (DIY) community to improve products (Buhr 2013). The model chosen for this research, OpenROV 2.8, is classified as a telerobotics mini-submarine controlled at the surface via a laptop and must be constructed by the user. The ROV’s unmodified weight is 2.6 kilograms (kg) [5.7 pounds (lbs.)], and its unmodified dimensions are 30 centimeters (cm) [11.8 inches (in.)] in length, 20 cm (7.9 in.) in width, and 15 cm (5.9 in.) in height. The OpenROV 2.8 used for this research was outfitted with a 200 meter (m) [656 feet (ft.)] long tether, which allowed for shipwrecks to be reached from a shore location. Maximum depth for the unit is 100 m (328 ft.), and it can produce a maximum forward speed of two knots, thus limiting the utilization of the ROV to environments with less than 2 knots of current. It is equipped with a high-definition webcam with a 120 degree field of view (FOV), while 2 scaling lasers calibrated at 10 cm (3.9 in.) separation provide the ability to measure dimensions underwater. A laptop with a RJ-45 Ethernet connector and free USB port controls the ROV via the web browser Google Chrome (internet access is not necessary for operation) and a Logitech F310 gaming controller can be connected to facilitate handheld piloting of the vehicle (OpenROV 2015). All the equipment necessary to run the OpenROV 2.8 can be contained in a standard-sized backpack and a Pelican 1520 case, making it a compact package and ideal for fieldwork.
GoPro Hero 4 Black cameras (Appendix C) were selected for this research since they have the ability to capture not only 1080p video resolution (known as high definition), but 4k video resolution (known as ultra high definition) as well. The 4k resolution setting offers 3,840 by 2,160 pixels, while the 1080p resolution setting consists of 1,920 by 1,080 pixels. Frame rate refers to the frequency at which frames are displayed; therefore, 1080p60 simply means that 1080p resolution was captured at a frame rate of 60 frames per second (fps), and 4k30 signifies 4k resolution captured at 30 fps, which is the highest frame speed the GoPro Hero 4 Black can capture for 4k resolution. In general, a higher frame rate capture speed often results in less blurry video footage; the quality of the video footage, however, is also effected by the resolution used. One of the aims of this thesis is to determine the best possible resolution and frame rate speed of video footage for photogrammetric purposes.

The OpenROV 2.8’s high-definition webcam is insufficient for photogrammetry due to issues with resolution and clarity. Furthermore, it is limited to only one angle of capture, and the collected footage can only be saved by recording the entire laptop screen, including the embedded head-up display (HUD), using an extension of Google Chrome named Screencastify. Thus, three GoPro Hero 4 Black cameras were attached to the ROV to give the system photogrammetric capability. These cameras were used to acquire video footage and save it in two different resolutions and frame rate speeds.

Securely mounting the GoPro cameras to the unit was an integral step in the data collection process. The OpenROV 2.8 has two threaded metal rods on its base that are perpendicular to the battery tubes. Conveniently, the holes at the base of the GoPro camera housing are compatible with the threaded rods on the ROV. Stainless steel nuts (size M5) on either side of the plastic housing mounts secured the GoPro cameras on the threaded rods. Four
nylon washers were placed in the space between the two teeth of the housing to prevent breaking when the steel nuts were tightened (Figure 1). When tightened sufficiently, the steel nuts do not allow the GoPro to move, effectively maintaining the camera at the desired angle to capture data.

Figure 1. Attachment of GoPro to a threaded rod of the OpenROV 2.8 (K. Clevenger 2016).

The first GoPro was placed on the forward threaded rod at an angle of approximately 45 degrees, facing forward. The second GoPro was placed on the aft threaded rod and positioned at zero degrees to capture footage directly below the ROV. The third and final GoPro was also placed on the aft threaded rod but pointed aft at an approximate angle of 25 degrees in order to capture footage behind the ROV (Figure 2). The modified weight of the ROV, after the addition of 3 GoPro cameras and removal of a 3 ounce ballast weight, is 2.97 kg (6.55 lbs.).
The initial orientation of the GoPro cameras failed to acquire all the photographic images needed to create complete 3D models of the first two case studies. For the latter three case studies, the ROV GoPro configuration was adjusted to better capture profile data. A three ounce weight on the port side of the ROV was removed, and a GoPro was secured facing outwards in its place, thereby capturing profiles on the port side of the ROV. The second GoPro was placed on the aft threaded rod and set to capture footage directly below the ROV, while the forward GoPro position remained unchanged from the initial camera configuration (Figure 3).
Data acquisition in the Great Lakes took place during the summer of 2016, while *Sinkentine* data collection occurred in November 2016. The OpenROV 2.8 was deployed on the four case studies in the Great Lakes from either a chartered boat or from the shoreline, while the final case study took place in a controlled environment at East Carolina University (ECU). Coded targets and/or scale bars were not used on the sites visited for this research, as the OpenROV 2.8 is incapable of deploying them. Data was collected using a flight path similar to the diver-based swim path (Figure 4) on the Gnalić wreck (*Yamafune et al. 2016*). Occasionally, it was necessary to dive or snorkel to retrieve the snagged ROV or untangle the tether cable from aquatic weeds.
Figure 4. Swim path followed to document the Gnalić wreck (Yamafune et al. 2016).

Post-processing of the recorded data included extracting still photographs from video footage, correcting lens distortion, and creating 3D models using Agisoft PhotoScan Professional Edition. An orthophoto (high resolution photomosaic with a uniform scale) was extracted from one of the 3D models and used to create a sketch conversion of the shipwreck in Adobe Photoshop CC 2017. Using the orthophoto and sketch conversion, a 2D site plan of that site was extrapolated using Adobe Illustrator CC 2017. The photogrammetric models created for this thesis were placed on Sketchfab, a website that provides free access to display and share 3D content.

1.4 Limitations

The accepted limitations of photogrammetry, such as poor results due to low visibility and high turbidity on sites, were expected from the onset of this thesis. The numerous limitations of the OpenROV 2.8, however, were not. As expected, the small size and weight of the OpenROV 2.8 inevitably made its use impractical in areas with significant surge and current; the
degree to which the unit was susceptible to these forces was surprising. The added payload of the three GoPro cameras did not allow the ROV to reach its top speed of two knots, thereby further limiting it to areas with current of less than one knot. Tether management was critical, especially on shipwrecks with high profiles and in areas covered with aquatic vegetation. Ultimately, the OpenROV 2.8 proved unable to fly in areas with dense vegetation, as the tether quickly became entangled and the small motors did not have enough power to clear it. Nearly every time the ROV was deployed, it suffered from water intrusion, mechanical error, or electrical error. Admittedly, this could result from the user’s lack of robotics experience when constructing the ROV. Another possible limitation could be the inability of the operator to notice small details of a shipwreck, such as a ceramic sherd or copper wire, when using an ROV rather than documenting a shipwreck using traditional diving and mapping techniques. These small details could be critical in accurately interpreting a shipwreck.

1.5 Conclusion

This thesis attempts to develop a methodology for rapidly recording shipwrecks using low-cost equipment to produce 3D photogrammetric models and 2D images with sufficient detail to allow for archaeological interpretation and analysis of a shipwreck site. At present, most remotely-controlled archaeological photogrammetric modelling is conducted using expensive cameras, ROVs, and/or AUVs. The outcome of this research could result in less time spent conducting field research to collect data and instead provide a more efficient and economical process for recording submerged cultural resources. Additionally, this research is uniquely applicable to sites located in cold, contaminated, and/or deep water.
2 Case Studies

The goal of this thesis is to develop a new methodology for recording shipwrecks using a low-cost ROV and video footage. As discussed previously, this concept was built upon the foundations of earlier projects involving photogrammetry (Drap et al. 2015; McCarthy and Benjamin 2014; Yamafune et al. 2016). Five case studies are examined in this chapter, each detailing the historical background of each of the vessels and their loss, archaeological data collection, the results of data processing, and conclusions for each particular site. A summary of the results and discussion of the most effective method for data collection concludes the chapter.

2.1 Atlanta Shipwreck

2.1.1 Historical Background

The first case study is that of the passenger freight propeller Atlanta (Registry Number: US106823). Owned by the Goodrich Transit Company, it was built at the Cleveland Dry Dockyard Company’s shipyard and launched on 26 April 1891. When launched, the 1,129.17 gross ton vessel registered 61 m (200.1 ft.) in length, 9.8 m (32.3 ft.) in beam, and 4.1 m (13.6 ft.) in depth and was outfitted with a compound, two-cylinder, fore-and-aft steam engine (The Buffalo Enquirer 1891a, 1891b).

The furnishings in the sleeping accommodations were lavish, with running water in every room and rosy pink woodworking. Adding to modern conveniences, Atlanta was furnished with electrical lighting, speaking tubes, and electric bells (Figure 5). The Goodrich Transit Company intended Atlanta to begin running on the Chicago, Illinois and Grand Haven, Michigan route in
late May 1891, but various setbacks delayed the furnishing to June of that year (The Buffalo Enquirer 1891a, 1891b).

Figure 5. Passengers on the deck of Atlanta circa 1895 (Courtesy of the Wisconsin Maritime Museum).

Atlanta transported passengers and package freight for the Goodrich Transit Company for the entirety of its working life and remained a passenger freight propeller until its demise. While on a run from Green Bay, Wisconsin to Chicago, Illinois on 18 March 1906, a fire which likely started in the engine room consumed the vessel while it was a few miles off Port Washington, Wisconsin. Fortunately, the fishing tug Tessler was nearby and saved the 2 passengers and 59 of the crew, with 1 deckhand drowning during the rescue attempt (The Chicago Inter Ocean 1906). The survivors were later transferred to the steamer Georgia, while Tessler towed the still burning Atlanta to a beach near Sheboygan, Wisconsin. In August 1920 salvors removed Atlanta’s boiler.
and engine (Dowling 1947). Sometime in the 2000s, treasure hunters illegally dynamited *Atlanta* in an attempt to find items of significant commercial value. As a result of the explosions, ceiling arches, metal pipes, and remaining machinery are dispersed over a wide area (Caitlin Zant 2016, pers. comm.).

Over a span of 10 days in late May and early June 2016, ECU’s Program in Maritime Studies recorded the sites as part of an archaeological field methods course. Working in conjunction with the Wisconsin Historical Society (WHS) and the Inland Seas Institute (ISI), *Atlanta* was documented using a traditional baseline offset methodology. During that time, numerous photos and swim-over videos were taken and later used to provide details of the interior of the wreck. In total, 5 graduate students, 3 crew chiefs, and a WHS intern spent over 100 hours mapping *Atlanta* and an additional 50 hours drafting the site plan. Since that time a National Register of Historic Places (NRHP) nomination for *Atlanta* has been completed and submitted to the Wisconsin State Review Board (Kiefer et al. 2016).

### 2.1.2 OpenROV 2.8 Test Flight

During the ECU field school, a test flight/swim of the OpenROV 2.8 was completed over the *Atlanta* shipwreck. Conditions at the site were less than ideal due to choppy waters, 0.6 to 1.2 m (2 to 4 ft.) swells, and surge. Since it was the last day of field operations and another opportunity for a test flight would not arise again for a month, the ROV was deployed without attachment of the GoPro cameras in case the tether cable broke and the ROV was detached. The ROV successfully navigated the wreck for 30 minutes before waves began to break over the bow of the small boat’s work platform, thus endangering the laptop used to pilot the ROV. The ROV was manually retrieved by its tether cable in order to expedite the recovery process.
2.1.3 Results and Conclusions from Test

The biggest limitation experienced while piloting the ROV on Atlanta was the surge, which made controlling it and flying it according to a pre-established path challenging. Its light weight and compact size make it desirable during transport and launch, but allow the ROV to be easily influenced by current and surge. This suggests the OpenROV 2.8 may not always be successful in gathering quality data in a high intensity underwater environment.

The heat given off by the light-emitting diode (LED) lights in the electronics tube caused the tube to fog up slightly which resulted in a foggy image being transmitted to the laptop screen and precise piloting challenging. To remedy this problem, a SCUBA mask defogger was applied to the tube which prevented fogging during subsequent flights. Though an improper seal resulted in a slight leak in one of the battery tubes, the freshwater did not cause serious damage to internal components.

2.2 Montana Shipwreck

2.2.1 Historical Background

The second case study for this project concerned the steamer Montana (US90501) (Bureau of Navigation 1872a). Built in Port Huron, Michigan, by master builder A.W. Smith of the Port Huron Dry Dock Company, Montana was launched in June 1872 (Port Huron Times 1872b). The vessel was enrolled as a propeller steamer with a four-cylinder steeple compound engine, two decks, one mast, and a round stern. Registering a length of 72 m (236.3 ft.), beam of 11.1 m (36.5 ft.), and depth of hold of 4.3 m (14 ft.), its original tonnage was 1,535.59 gross tons, with 910.03 tons below decks and 625.56 tons between decks (Figure 6). Montana was owned by the Western Transportation Company of Buffalo, New York from 1872 to 1877 and served as a package
freighter under Captain H.D. Pheatt (Bureau of Navigation 1872a, 1872b; Port Huron Times 1872a).

Figure 6. Montana shortly after its launch in 1872 (Courtesy of Alpena County George N. Fletcher Public Library).

On 24 April 1877, Montana was sold to New York Central Railroad’s Western Transit Company of Buffalo (Bureau of Navigation 1877). For the next 27 years, the vessel transported package freight and passengers throughout the Great Lakes. On a run from Duluth, Minnesota to Buffalo, New York, on 26 September 1895, Montana was holed and lost its rudder and shoe when it struck the bank near the Portage Lake Canal. As a result, the vessel sank in 4.9 m (16 ft.) of water and lost its entire cargo of flour. Fortunately, it was not carrying passengers at the time and was refloated (Detroit Free Press 1895).
In 1904, *Montana* was sold to the Great Lakes Engineering Works of Ecorse, Michigan, and its homeport shifted to Detroit (Bureau of Navigation 1904). From 1908 to 1910, the vessel was sold a total of six times before coming under the ownership of J.E. Sheehan and George C. Burns, who moved its homeport to Buffalo, New York (Bureau of Navigation 1908a, 1908b, 1909a, 1909b, 1909c, 1909d, 1910a, 1910b). In 1910, *Montana* was rebuilt in Sturgeon Bay, Wisconsin, as a lumber carrier with one deck and two masts. Its new tonnage was calculated at 1,212.60 gross tons, with 910.03 tons below decks and 302.57 tons enclosed on the upper deck (Bureau of Navigation 1910c). On 6 September 1914, while en route from Detroit to Georgian Bay to load lumber, *Montana* caught fire and burned to its waterline. The steamer sank in 19.2 m (63 ft.) of water off Thunder Bay, Michigan’s North Point with no lives lost (Bureau of Navigation 1914b).

During the summer of 2015, maritime archaeologists with TBNMS recorded the remains of the shipwreck. The steeple compound engine, boiler, shaft, and propeller remain on the site. A site plan (Figure 7) was produced, though approximately 9.1 m (30 ft.) on the starboard side towards the bow was not recorded due to time constraints. Further fieldwork is required in order to complete the site plan, and TBMNS maritime archaeologists are currently developing a comprehensive report of investigations (Phil Hartmeyer 2016, pers. comm.).
Figure 7. Site plan of Montana. No north arrow or scale provided by TBNMS (Thunder Bay National Marine Sanctuary 2015).
2.2.2 **Customized OpenROV 2.8 Test Flight**

For the first test flight with the OpenROV 2.8 customized with the addition of three GoPro cameras, the unit was launched from a chartered boat. Almost immediately the tether became entangled on the mooring line, which created variation in pitch and yaw and made piloting the ROV challenging. Pitch refers to the up and down movement of the unit and yaw refers to its side-to-side movement. Due to current and resistance from the entangled tether line, the highest speed possible was used in an effort to continue the flight and 1080p60 video resolution of the boiler and nearby planking was captured before the ROV became too entangled to continue operations. Divers retrieved the ROV and discovered leaking battery tubes upon surfacing. The operation was terminated to prevent further damage to the unit.

2.2.3 **Results and Conclusions from Test**

Dramatic pitch and yaw experienced during the flight caused blurred edges in still photographs extracted from the video footage. Another cause of blurred edges was the speed at which the ROV was operated. A thrust factor of five equates to the unit’s top speed of approximately two knots, which may be too fast to capture high quality video footage for photogrammetric purposes. Ultimately, the blurred edges did not allow the photogrammetric software to align the photos.

During post-processing, it became apparent that the GoPro placement was inadequate for capturing the shipwreck’s profile, as *Montana*’s machinery causes a height variation of approximately 6 m (20 ft.). In order to capture such a profile, a GoPro must be attached on the side of the ROV. Shipwrecks with large profiles may further complicate flying an ROV, as concerns for tether management and entanglement increase greatly with structural height.
2.3 **Bullhead Point Shipwrecks**

2.3.1 **Historical Background**

The third case study undertaken for this research involved the Bullhead Point Shipwrecks. Bullhead Point, located in Sturgeon Bay, Wisconsin, is home to three shipwrecks and a large pier/wharf that comprise a single archaeological site. The site, historically used as a quarry dock by the Sturgeon Bay Stone Company, includes the converted barges *Oak Leaf*, *Ida Corning*, and *Empire State* (*Door County Advocate* 1903, 1910). *Empire State* is the easternmost wreck, *Oak Leaf* the westernmost, and *Ida Corning* rests between the two.

![Bullhead Point Shoreline Map](image)

*Figure 8. Shoreline map of Bullhead Point with the location of the site’s shipwrecks (Rodgers and Green 1999).*
*Empire State* (US7229), built in 1862 by Charles S. Bidwell, was constructed for Charles Ensign, an agent of the People’s Line of Propellers (*Buffalo Evening Courier and Republic* 1862a, 1862b, 1862c; *Detroit Free Press* 1862). Built as a wooden steam passenger freight propeller with two decks and one mast, the vessel was powered by a high pressure one-cylinder engine and firebox boiler purchased from Shepard Iron Works of Buffalo, New York. Originally, *Empire State* registered 64 m (210.1 ft.) in length, 9.9 m (32.4 ft.) in beam, 4 m (13.2 ft.) in depth, and 860.87 gross tons (*Chicago Times* 1862).

For the next 40 years, *Empire State* ran passenger lines between Buffalo, New York, and Milwaukee, Wisconsin. In 1868 *Empire State* received an upgrade in the form of a fore and aft compound engine (*Detroit Free Press* 1868). Shortly thereafter, it collided with and sank both the schooner *Dundenburg* and the propeller *Wabash* (*Goderich Signal* 1868, *Port Huron Times* 1870, *Chicago Times* 1870, *Chicago Tribune* 1870). For over 30 years, it continued in good service before receiving an engine replacement in the form of a steeple compound engine made by N.G. Trout of Buffalo, New York in 1904. A short time later on 25 December 1906, *Empire State* burned at its dock in Chicago, Illinois and began its journey to abandonment (*Manitowoc Daily Herald* 1906). In 1908 Leatham D. Smith rebuilt the vessel as a 64.6 m (212 ft.) long, 9.9 m (32.7 ft.) in beam, and 3.7 m (12.2 ft.) deep barge with 1 deck, no mast, and a gross and net tonnage of 637 tons (*Manistee Daily Advocate* 1907). In 1910, the barge was purchased by the Sturgeon Bay Stone Company, which ultimately abandoned it at Bullhead Point on 18 March 1916 (Green et al. 2002).

The three-masted schooner *Oak Leaf* (US19106) was built in 1866 for Captain Henry Kelly by Peck and Masters of Cleveland, Ohio. Equipped with 1 deck, the vessel measured 39.6 m (129.9 ft.) in length, 9.4 m (31 ft.) in beam, 3.4 m (11.2 ft.) in depth, and 319.36 gross tons (Board of
Lake Underwriters 1866). Captain Kelley sailed *Oak Leaf* on Lakes Erie and Michigan, carrying lumber and general cargo. In 1891 the vessel was modified to 48.8 m (160 ft.) in length, 9.5 m (31.2 ft.) in beam, 3.2 m (10.5 ft.) in depth, and 395 gross tons (Board of Lake Underwriters 1891). In 1901 *Oak Leaf* was converted into a schooner barge and in 1906 was sold to the Sturgeon Bay Stone Company and converted into a barge (Board of Lake Underwriters 1901, *Door County Advocate* 1906). Throughout its life, *Oak Leaf* experienced several minor collisions and ran aground numerous times. The vessel was retired in 1920 when it sank at its dock as a result of a leak (Van Harpen 2003:3).

The schooner barge *Ida Corning* (US44283) was built in East Saginaw, Michigan in 1881 by Thomas Arnold. Equipped with 2 masts, it was 51.2 m (168 ft.) in length, 9.5 m (31.3 ft.) in beam, 3.3 m (10.9 ft.) in depth, and 444 gross tons (Board of Lake Underwriters 1881). Originally built to be towed in consort with other schooner barges, *Ida Corning* was never intended to sail under its own power. As a result of the lumber industry waning in the late 19th century, the schooner barge was sold to the Sturgeon Bay Stone Company and converted into a stone barge in 1908 (*Door County Advocate* 1910). Much like *Empire State*, it is unclear when the barge was no longer used to haul stone and laid up at Bullhead Point.

Sometime after abandonment, the Sturgeon Bay Stone Company converted each of the vessels at Bullhead Point into docks by filling them with stone, and thereby extending its wharf. In June 1931, a fire began on *Ida Corning*, possibly started by a fisherman’s cigarette stub. The following day the fire spread to the neighboring *Oak Leaf* before jumping to *Empire State*. Over the course of four days, all three vessels burned to the waterline without any attempt to stop the fire (*Door County Advocate* 1931). In the 1960s, divers salvaged an anchor from either *Ida Corning* or *Oak Leaf* (Van Harpen 2003:3).
In 1999 staff and students from ECU’s Program in Maritime Studies conducted a non-intrusive Phase II survey of the three shipwrecks located at Bullhead Point. This project resulted in the production of individual plans of each shipwreck and an overall site map of the three vessel remains and Bullhead Point (See Figure 8) (Rodgers and Green 1999). In 2002 underwater archaeologists from the WHS returned to Bullhead Point and captured photographs and video footage of the site. A NRHP nomination for the shipwrecks at Bullhead Point was completed in 2002 (Green et al. 2002). Since then no further archaeological investigation is known to have been conducted on the site.

2.3.2 **Data Collection with the Customized OpenROV 2.8**

For ROV operations at Bullhead Point, a round pool float was attached to the tether line to minimize the threat of entanglement. To do this, 1 section of pool float was attached to the tether 1.8 m (6 ft.) from where it connects to the ROV; this measurement was selected since the maximum depth of the shipwreck site is 1.8 m (6 ft.). The remaining sections of pool float were attached to the tether at 3 m (10 ft.) intervals. The application of the floats not only decreased the likelihood of tether entanglement, but also allowed an archaeological assistant acting as the tether tender to determine the amount of tether paid out. This addition of the float material was considered a success since it kept the tether from settling to the bottom of the lakebed, provided the pilot with an accurate ROV location, and was an inexpensive solution.

With the thrust factor set on two, the ROV successfully captured video footage of *Ida Corning* before the flight was terminated due to the presence of thick aquatic weeds that ensnared the ROV and tether cable. The captured video footage provided the necessary camera angles to adequately document a portion of the shipwreck for photogrammetric purposes. Still photographs extracted from the video did not exhibit the blurred edges seen on the stills of
Montana. A thrust factor of 2 – approximately 0.7 knots – proved to be an appropriate speed for data collection.

2.3.3 Results and Conclusions

Despite the addition of sections of pool float which kept the tether off the lakebed and out of the wreck, a large portion of the Bullhead Point site was covered with aquatic vegetation. The small ROV, even using thrust factor five, could not penetrate the thick weed pockets on much of the site. When it successfully navigated through areas of less dense weeds, the tether quickly became ensnared and resulted in too much drag for the ROV to overcome. Due to the presence of the aquatic weeds, video footage was limited and prevented the production of a photogrammetric model of the entire site. Collecting video footage at this site in the fall or early winter shortly before ice formation or in the spring shortly after the ice melts might result in the presence of fewer aquatic weeds and better visibility, which could in turn increase the chances for a successful photogrammetric survey.

2.4 Portland Shipwreck

2.4.1 Historical Background

The most successful case study was that of the two-masted schooner Portland (US19623). Built in 1863 by John Oades in Clayton, New York for Alden F. Barker, the schooner measured 42.1 m (138 ft.) in length, 7.9 m (26 ft.) in beam, and 3.6 m (11.9 ft.) in depth with a gross tonnage of 345.29 and a cargo capacity of 24,000 bushels. Portland sailed between Buffalo, New York and Chicago, Illinois in 1863 delivering bulk cargoes (Buffalo Daily Courier 1863). In October 1866, the schooner collided with another vessel in the St. Clair Flats and lost its jibboom (Buffalo Commercial Advertiser 1867). Portland received a new keel, bottom, pocket pieces, and two heavy keelsons in 1868 (Chicago Tribune 1868). The schooner grounded on Bois Blanc Island in the
Detroit River in November 1869, and in July 1871 collided with the bark *Naiad* at Chicago, causing the bark to lose its foremast (*Detroit Free Press* 1869, Hall 1870, Hall 1872). The vessel ran aground in the St. Lawrence River during a snowstorm in November 1872, shortly before being purchased by D. Whitney, Jr. (*Buffalo Daily Courier* 1872, *The Toronto Mail* 1872). In 1874, *Portland*’s yawl was smashed in the St. Clair Flats, presumably in a collision with another vessel (*Chicago Inter Ocean* 1874). The final owner of *Portland* was John Pridgeon of Detroit, who purchased the vessel in 1876 and ran it on the Pridgeon Line (*Daily Globe* 1877).

Reports of the reason for the *Portland*’s wrecking differ depending on the source. An article from the *Daily Globe* (1877) states that *Portland* was pushed ashore near Presque Isle, Michigan in Lake Huron during an October 1877 gale that damaged several other vessels. The *Detroit Free Press* (1877) states that the schooner sprang a leak and was intentionally run into False Presque Isle in an attempt to save it from sinking. Despite attempts to free the schooner by the wrecker *Leviathan*, *Portland* broke into pieces a few days after wrecking and was declared a total loss (*Cleveland Herald* 1877, *Port Huron Daily Times* 1877).

*Portland*’s anchor and chain were salvaged in 1879 and placed on the schooner *Nellie Gardner*. Captain Pridgeon, who was overseeing the transfer of the anchor, stated that the anchor and chain were worth $12,000. This high price was a result of a $12,000 mortgage on *Portland*, and the only things salvaged that were of any value were the anchor and chain (*Detroit Free Press* 1879, *Detroit Post & Tribune* 1879).

Previous archaeological work on *Portland* was conducted by the Michigan State Underwater Archaeology program on 13 August 2007. Using standard mapping methods, part of the keelson structure and some of the planking (Figure 9) were recorded (Wayne Lusardi 2016, elec. comm.). The articulated keelson structure and starboard side of the vessel are located within
the boundaries of TBNMS. Fortunately, the shoreline adjacent to *Portland* is part of Michigan Department of Natural Resources’ Besser Natural Area, so it is possible to reach the site using public land. *Portland* was selected as a case study due to ease of access; it is only a half mile walk along the shoreline from the nearest parking lot. The farthest portion of the shipwreck is 180 m (590.6 ft.) from shore, thus making it possible for the ROV to cover the entire wreck site with the 200 m (656 ft.) long ROV tether line.

Figure 9. Incomplete site plan of *Portland*. No north arrow or scale provided by recorder (W. Lusardi 2007).
2.4.2 **Data Collection with the Customized OpenROV 2.8**

For the first attempt to record video footage of *Portland* with the OpenROV 2.8, several snorkelers were on site, thus eliminating the possibility of collecting adequate data in one day. A reconnaissance snorkel of the shipwreck was conducted, and it was decided that only the articulated pieces of the site would be used for this study. A measurement of a timber adjacent to the keelson was taken and later used to scale the 3D model and 2D site plan.

A second attempt to collect data on *Portland* proved unsuccessful due to a strong east wind which created waves large enough to prevent the ROV from reaching *Portland*. The water was too shallow for the ROV to submerge sufficiently to avoid the waves, and it was battered on the dolomitic limestone covering the lakebed. The operation was terminated after an hour of attempting to reach the site.

The first completely successful ROV flight at the *Portland* site occurred several days later, as a result of pristine weather conditions, lack of potential entanglements on the site, and the absence of tourists. Lake Huron was perfectly flat and no surge or current was detected. Operating on a thrust factor of two, the ROV quickly reached the stern of *Portland* and collection of 1080p60 video footage began. Flying along the path (Figures 10, 11, 12) determined during the snorkel reconnaissance of the site, 28 minutes of 1080p60 resolution video footage was collected. Upon completion, the ROV returned to shore, where the GoPro cameras were switched to 4k30 video resolution in preparation for a second deployment. The same patterned path (Figures 10, 11, 12) was flown over the shipwreck, and 29 minutes of 4k30 video resolution was collected. Just over two hours was spent collecting video footage of *Portland*. This included walking to the site, preparing the ROV for deployment, collecting video footage using two different resolutions, packing equipment, and returning to the vehicle.
Figure 10. Path flown for profile data collection of Portland (K. Clevenger 2016).
Figure 11. Longitudinal flight path of Portland (K. Clevenger 2016).
Figure 12. Transversal flight path of Portland (K. Clevenger 2016).
2.4.3 Results and Conclusions

The small size of the OpenROV 2.8 makes it a convenient piece of equipment for use in areas with restricted access by vehicle. The same feature, however, also makes it challenging for the ROV to cope with waves and current. Capable of a maximum speed of only two knots, the OpenROV 2.8 was no match for the waves on the second attempt to gather data on Portland. Due to cost restraints, the ROV was deployed and piloted from the shoreline rather than a boat, and the stem of Portland was situated at the extent of the area within reach of the 200 m (656 ft.) long tether. Although for this particular site, tether line limitations proved irrelevant, they must be taken into account when selecting future sites for recording.

2.5 Sinkentine

2.5.1 Historical Background

The final case study was conducted in ECU’s Minges Natatorium to demonstrate the OpenROV 2.8 to faculty members. In 1989 then-director of the Program in Maritime History and Underwater Research at ECU, Dr. Gordon Watts, Jr., designed and constructed a fiberglass replica of a partial ship’s hull with the aid of a grant from the National Trust for Historic Preservation. The 3 m by 3 m (10 ft. by 10 ft.) replica was constructed on a 1:0.5 scale and consisted of a keelson, frames, floors, and hull planking. Details included various types of fasteners, tool marks, and limber holes. By constructing it in sections, the so-called Sinkentine is easily moved from storage to a swimming pool and can be deployed underwater in a matter of minutes (Watts 1989). Designed to teach students the nuances of traditional underwater mapping, Sinkentine provided another case study used for photogrammetric purposes.
2.5.2 Data Collection with the Customized OpenROV 2.8

With faculty assistance, the keelson structure and 3 of Sinkentine’s frames were submerged in the 4.6 m (15 ft.) deep dive pool. The customized ROV collected video footage of Sinkentine in a controlled environment using all the techniques developed during earlier flights which resulted in smooth data collection (Figure 13).

![Modified OpenROV 2.8 collecting video footage of Sinkentine (J. Raupp 2016).](image)

2.5.3 Results and Conclusions

The customized OpenROV 2.8 successfully collected 1080p60 and 4k30 video of Sinkentine in approximately 15 minutes. By utilizing techniques learned during earlier flights, such as proper camera placement and floats on the tether, the acquisition of data took little time, and the ROV did not become entangled or experience minor leaking in the battery tubes.
2.6 Conclusion

The selected case studies were chosen due to their location in the Great Lakes, original dimensions, and various depths of water. The passenger freight propeller Atlanta sank in 1906 in approximately 4.6 m (15 ft.) of water, and its remains are easily reached by boat (The Chicago Inter Ocean 1906). Its original size – 61 m (200.1 ft.) in length, 9.8 m (32.3 ft.) in beam, and 4.1 m (13.6 ft.) in depth – made it an ideal candidate for testing this new methodology (The Buffalo Enquirer 1891a, 1891b). The shipwreck Montana was selected as a case study due its significant profile relief – approximately 6 m (20 ft.) – and its location in deeper water which provided a slightly different environment to test the customized ROV in than Atlanta’s final resting place. The shipwrecks located at Bullhead Point and the Portland site were chosen primarily because it was possible for the ROV to reach them when deployed from the shoreline. Additionally, the overall dimensions of each were the desired size – less than 70 m (230 ft.) in length – to test this methodology, and their locations in shallow water reduced the risk of losing the ROV. The final case study on Sinkentine was conducted to demonstrate the customized OpenROV 2.8 with its final adjustments on a test subject in a controlled environment.

Numerous limitations arose during data collection for this project, many of which were overcome with problem solving skills and creativity. It quickly became apparent that simply attaching three GoPro cameras to the OpenROV 2.8 would not be sufficient for data collection for photogrammetric purposes. Weight needed to be removed from the ROV to compensate for the additional weight of the three cameras and still allow for piloting. The tether cable, frequently in danger of becoming snagged, was modified with the addition of pieces of buoyant foam, and camera positions were altered in order to capture all views required to construct a complete photogrammetric model. After the final camera adjustments and alterations to the
tether cable were complete (See Figure 4), the customized OpenROV 2.8 successfully gathered data suitable for creating photogrammetric models of shipwrecks.
3 Data Processing

This chapter discusses the use of a variety of software to process video footage of shipwrecks to create 3D models and 2D site plans. The process described herein begins with Adobe Photoshop CC 2017, first used to eliminate segments of video that did not capture images of the shipwreck before still photographs were extracted. The next step in data processing involved the use of Adobe Lightroom CC 2017 to correct lens distortion of the still photographs – GoPro video is captured in wide angle FOV. Agisoft PhotoScan Professional Edition was then used to build 3D models of the shipwrecks, which were later uploaded to Sketchfab, an open-source website for sharing 3D models. Following the creation of the 3D models in PhotoScan, an exported orthophoto of Portland was imported into Photoshop and converted into a sketch image. Finally, using the orthophoto of Portland and the sketch conversion image, a 2D site plan was created in Adobe Illustrator CC 2017. While other software can be used to edit video footage and create site plans, Adobe software was selected for this thesis because it is available in a relatively inexpensive software package that gives the user access to all of the Adobe products. PhotoScan, with its ability to create 3D models from images that other photogrammetric software cannot properly process, made it the ideal photogrammetry software for this research. Below are the detailed explanations of each step.

3.1 Adobe Photoshop CC 2017

After downloading and backing up raw video footage obtained from the GoPro cameras, the process of creating a 3D model began. The first step in this process was elimination of raw video footage that did not contain images of the shipwreck. Due to the positioning of the GoPro cameras on the OpenROV 2.8, useful footage was not always captured when the ROV was
piloted over a shipwreck in a predetermined flight pattern. The process of cropping footage that contained the surrounding seascape was straightforward.

In order to separate fore, aft, and profile folders that corresponded to the cameras’ locations on the ROV, one video was opened within Photoshop at a time. After importing a video, the “cut” tool was used to create a stopping point when the video did not display shipwreck features (Figure 14). The “cut” tool was used again when the video began to display shipwreck features once more.

This process was repeated for the entirety of the video. Each time the “cut” tool was used, a new “layer” was created and could be viewed on the side panel (Figure 15). The layers that lacked the useful data were then deleted by highlighting, right clicking, and selecting “Delete Layer” in the side panel.
After deleting unnecessary footage, still frames were extracted from the remaining video by selecting the small arrow located in the bottom left corner of the video editing work pane (Figure 16). An “Extracted Stills” folder was created for the still photographs and “Photoshop Image Sequence” was selected from the dropdown menu. “JPEG” was the designated file format, and the quality of the jpeg was set to maximum. Frame rate was set to “Custom” and the desired fps – one fps was usually adequate and did not result in too many pictures for PhotoScan to process – was selected. When the settings were appropriately adjusted, the “Render” button was clicked (Figure 17).
Figure 16. Location of the extract still photographs arrow in Photoshop (K. Clevenger 2017).

Figure 17. Render video pane with appropriate settings selected in Photoshop (K. Clevenger 2017).
The processing power of the computer used to create the 3D models determined the number of fps rendered. A greater number of photos used to build the model resulted in more photo overlap, thereby creating more detail in the resulting model. Video rendered at two fps had twice as many photos as frames rendered at one fps; the processing power of the computer employed for this research, however, was insufficient to run PhotoScan with that many photos and would take weeks to process. To avoid this, a balance was found between the number of images and the computer’s processing power; determining this depended on the capabilities of the computer, the desired results, and the time allotted for creating the model.

3.2 Adobe Lightroom CC 2017

PhotoScan has the ability to automatically correct lens distortion in photographs when they contain original metadata. Unfortunately, after extracting still photographs from video footage metadata was lost, which resulted in lens distortion being corrected using photo editing software. The software used for this project was Adobe Lightroom CC 2017.

Creating a new catalog for each folder of still photographs kept images organized. After importing the images (Figure 18), lens distortion was corrected in one image by navigating to the “Develop” work pane, and under “Lens Correction,” manually correcting the distortion in the image with the “Constrain Crop” feature (Figure 19). The lens correction setting used was “+10” for all images used in this project.
Figure 18. Importing bulk images into the Lightroom catalog (K. Clevenger 2017).

Figure 19. Correcting wide angle lens distortion in Lightroom (K. Clevenger 2017).
After navigating to the library and using the “Grid View” to view all images, the distortion correction was applied to the entire catalog by using the “CTRL+A” command to highlight all images and “Sync Settings” was selected. “Lens Corrections” settings were enabled (Figure 20), and upon completing the distortion correction, the images were ready for use in creating a 3D model. Although it was not done for this research since it was not necessary, color correction of images can be done in Photoshop or Lightroom, prior to their use in PhotoScan.

![Synchronize Settings](image)

Figure 20. Synchronize settings to correct lens distortion for all images in Lightroom (K. Clevenger 2017).

3.3 Agisoft PhotoScan Professional Edition

Since its release in 2010, Agisoft PhotoScan has become the predominant mapping software based on multi-image photography used by archaeologists. With a workflow (Appendix A) incorporating four basic steps (Align Photos, Build Dense Cloud, Build Mesh, and Build
Texture), it is a user-friendly program that maintains a high degree of accuracy when each step is performed properly.

To function effectively, PhotoScan requires 60 percent overlap of the images in order to align them, meaning the software uses details in neighboring images to essentially stitch them together and create a 3D model (Agisoft LLC 2016). When the percentage of overlap is increased, the result is a more detailed 3D model; therefore, a greater number of high-quality images will produce a more detailed final product. A computer with a processing speed of at least 2 gigahertz (GHz) and a sufficient amount of installed Random Access Memory (RAM) is required to process a large number of images (i.e. 1,000 or more). In the event that the computer lacks the necessary specifications, it will either experience a system crash or take weeks to generate a 3D model in PhotoScan. A computer equipped with a processing speed of 2.5 GHz and 16 gigabytes (GB) of RAM will take approximately 1 week to process 1,000 images into a 3D model using PhotoScan. Increasing the processing speed and RAM results in a decrease of time needed for PhotoScan to process a 3D model.

For this thesis, two computers were used to create the 3D models. The first, a Dell Precision T7910 housed at the University of North Carolina’s Coastal Studies Institute (CSI), was used to process the 4k30 and 1080p60 models of Portland. The second, a Toshiba Satellite S55t-B, was used to process the models of Sinkentine.

Table 1. Computer specifications.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Dell Precision T7910</th>
<th>Toshiba Satellite S55t-B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel(R) Xeon(R) CPU E5-2667 v3 @ 3.20 GHz</td>
<td>Intel(R) Core™ i7-4710HQ CPU @ 2.50 GHz</td>
</tr>
<tr>
<td></td>
<td>3.20 GHz (2 processors)</td>
<td>2.50 GHz (1 processor)</td>
</tr>
<tr>
<td>Installed Memory (RAM)</td>
<td>128 GB RAM</td>
<td>16 GB RAM</td>
</tr>
<tr>
<td>System Type</td>
<td>64-bit Operating System, x64-based processor</td>
<td>64-bit Operating System, x64-based processor</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 10 Pro</td>
<td>Windows 10 Home</td>
</tr>
</tbody>
</table>
The same settings were used when processing all 3D models, thus eliminating the need to analyze results from numerous settings (Table 2). After each step was completed (Figures 21, 22, 23, 24), unnecessary floating points on the models were deleted, and the bounding box was decreased to the smallest possible size without deleting data. This step removed unnecessary points or faces, made the models cleaner, and decreased processing time.

Table 2. PhotoScan settings used for all 3D models created for this thesis.

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Photos</td>
<td>Accuracy→High</td>
</tr>
<tr>
<td></td>
<td>Pair preselection→Generic</td>
</tr>
<tr>
<td></td>
<td>Key point limit→80,000</td>
</tr>
<tr>
<td></td>
<td>Point limit→1,000</td>
</tr>
<tr>
<td>Build Dense Cloud</td>
<td>Quality→Medium</td>
</tr>
<tr>
<td></td>
<td>Depth filtering→Mild</td>
</tr>
<tr>
<td>Build Mesh</td>
<td>Surface type→Arbitrary</td>
</tr>
<tr>
<td></td>
<td>Source data→Dense cloud</td>
</tr>
<tr>
<td></td>
<td>Face count→High</td>
</tr>
<tr>
<td></td>
<td>Interpolation→Enabled</td>
</tr>
<tr>
<td>Build Texture</td>
<td>Mapping mode→Generic</td>
</tr>
<tr>
<td></td>
<td>Blending mode→Mosaic</td>
</tr>
<tr>
<td></td>
<td>Texture size/count→6,000 x 3</td>
</tr>
<tr>
<td></td>
<td>Color correction deselected</td>
</tr>
</tbody>
</table>
Figure 21. “Align photos” process of *Portland* from 1080p60 resolution in PhotoScan (K. Clevenger 2017).
Figure 22. “Dense cloud” process of Portland from 1080p60 resolution in PhotoScan (K. Clevenger 2017).
Figure 23. “Mesh” process of *Portland* from 1080p60 resolution in PhotoScan (K. Clevenger 2017).
Figure 24. “Texture” process of Portland from 1080p60 resolution in PhotoScan (K. Clevenger 2017).
After completing the four basic steps for creation of a 3D model, it was necessary to complete a fifth step, “Build Orthomosaic,” before an orthophoto of any desired projection was exported (Figure 25). For this thesis, the 3D models were manually orientated to the plan view, and the orthophoto was created as a planar projection with the projection plane set on “Current View.” The pixel size of the orthophoto varied for each model and, where necessary, was either reduced for higher resolution or left at the default size. If the photos used to create the model had XYZ coordinates, the geographic projection was most appropriate, and allowed the created orthophoto to automatically position itself in the correct orientation in ESRI ArcGIS when uploaded (Appendix B). The orthophoto was exported as a JPEG, PNG, or TIFF file for future use in Photoshop (Figure 26).

![Build Orthomosaic](image)

Figure 25: “Build orthomosaic” process with projection plan: current view in PhotoScan (K. Clevenger 2017).
Figure 26. Orthophoto of Portland from 4k30 resolution (K. Clevenger 2017).
3.4 Sketchfab

In order to share the 3D models that resulted from this thesis research with colleagues and the public, they were placed on Sketchfab (www.sketchfab.com/katieclevenger). A “Basic” plan on Sketchfab is free of charge but limits file size of models to 50 MB each. A “Pro” plan costs $10 per month, requires registration with a personal email account, and allows the user to upload file sizes up to 200 MB; when registering with an academic institution’s email address, however, a “Pro” plan is free. Models can be directly uploaded to Sketchfab from PhotoScan with the user’s personal account application programming interface (API), located in the settings (Figure 27). “Upload Model,” located under the File tab in PhotoScan, was selected, and the Sketchfab API added under “API token” (Figure 28). Uploading models using this method, rather than selecting “Upload” on the Sketchfab website, kept file sizes smaller.

Figure 27. Location of API token in Sketchfab (K. Clevenger 2017).
Figure 28. Models are loaded to Sketchfab directly from PhotoScan (K. Clevenger 2017).

After uploading the model, it was orientated to the desired view when the webpage loaded by adjusting the 3D settings (Figure 29). Additionally, the model was annotated to highlight features of the shipwreck and provide historical information (Figure 30). This website is a phenomenal tool for public outreach, as it is free, user-friendly, and accessible to everyone with an internet connection.
Figure 29. Orientating the model to the desired view in Sketchfab (K. Clevenger 2017).

Figure 30. Example of an annotation in Sketchfab (K. Clevenger 2017).
3.5 Extrapolating Site Plans

After completing the 3D models and exporting an orthophoto, the process of creating a sketch conversion and site plan of the shipwreck began. For this thesis, the orthophoto of the *Portland* model created from 4k30 video was the only one used during this step, since it showed the entirety of the articulated portion of the shipwreck and was highly detailed (See Figure 26). The *Portland* model created from 1080p60 footage was incomplete, and as *Sinkentine* was not an historical shipwreck, a site plan was not created.

After uploading *Portland*’s orthophoto to Photoshop, it was possible to alter or enhance the image in numerous ways. The input and output levels (Image→Adjustments→Levels) were tuned to make the image brighter without altering the contrast, thereby allowing features to be more visible (Figure 31).

Figure 31. Orthophoto of *Portland* with adjusted levels in Photoshop (K. Clevenger 2016).
To create a sketch conversion image, the copied layer of the orthophoto was changed to black and white (Image ➔ Adjustments ➔ Black & White…) (Figure 32).

Figure 32. Black and white image of Portland orthophoto in Photoshop (K. Clevenger 2016).
Working from a duplicated black and white layer, a “Glowing Edges” image was created (Filter→Filter Gallery…→Stylize→Glowing Edges) (Figure 33). For the first attempt at creating a sketch conversion, the “edge width” was set to 2, the “edge brightness” was set to 20, and the “smoothness” was set to 15 (Figure 34). Upon inverting (Image→Adjustments→Invert) the glowing edges image, the resulting image lost a significant amount of detail and was inadequate for creating a site plan (Figure 35). Another duplicate layer of the black and white layer was created, and the glowing edges feature was set to an “edge width” of 1, an “edge brightness” of 20, and a “smoothness” of 2 (Figure 36). After inverting the image, the crisp lines and details of the orthophoto were still visible and in some areas had become more prominent (Figure 37).

Figure 33. “Glowing Edges” menu in Photoshop (K. Clevenger 2016).
Figure 34. “Edge width” 2, “edge brightness” 20, “smoothness” 15 in Photoshop (K. Clevenger 2016).
Figure 35. Inverted image of “edge width” 2, “edge brightness” 20, “smoothness” 15 in Photoshop (K. Clevenger 2016).
Figure 36. “Edge width” 1, “edge brightness” 20, “smoothness” 2 in Photoshop (K. Clevenger 2016).
Figure 37. Inverted image of “edge width” 1, “edge brightness” 20, “smoothness” 2 in Photoshop (K. Clevenger 2016).
Using the sketch conversion as a background image, a site plan was extrapolated using Adobe Illustrator CC 2017 by tracing the lines of the sketch conversion. The distinct features of the shipwreck were created in different layers to keep the site plan organized (Figure 38). A scale was applied to the site plan using the measurement recorded by the 10 cm (3.9 in.) calibrated scaling lasers on the OpenROV 2.8, and the final product was exported with the base image disabled (Figure 39).

Figure 38. Creating a site plan in Illustrator with the sketch conversion image as the base image (K. Clevenger 2016).
Figure 39. Completed site plan of *Portland* (K. Clevenger 2016).
3.6 Conclusion

This chapter presented the use of Adobe Photoshop CC 2017 and Lightroom CC 2017 to prepare raw video footage captured by GoPro Hero 4 Black action cameras for use in Agisoft PhotoScan. The resulting 3D models were placed on Sketchfab to make them accessible to colleagues and the public, and the orthophoto of *Portland* extracted from the 4k30 model was altered in Photoshop to create a sketch conversion image. The sketch conversion was used as the background image in Adobe Illustrator CC 2017 to extrapolate a 2D site plan by tracing the features seen in the base image. This site plan may allow for archaeological interpretation of *Portland*'s wrecking event and provide insight into the site formation processes that have affected the site. Additionally, the 3D models and 2D site plans created with this methodology can be used to help better manage shipwrecks and more readily monitor changes occurring to the sites.
4 Analysis

This chapter discusses the analysis of the 3D models created for this project and presents a comparison of the quality of data produced from the 4k30 and 1080p60 resolutions and frame rates. In addition, a standard mapping-based site plan will be compared to the photogrammetry-based site plan. An interpretation of Portland’s wrecking event based on the 3D models and 2D site plan and an analysis of the 2D site plan is discussed. Increasingly, as is the case in all professions, cultural resource managers and archaeologists are concerned with productivity, efficiency, and funding. Contracts and grants are vital resources used to conduct archaeological fieldwork, and the time required to achieve the goals outlined in many contracts and grants must be carefully planned. This chapter, therefore, concludes with a productivity analysis of the time, workforce, and financial resources expended to complete this photogrammetry-based project.

4.1 Analysis of 3D Models

For this thesis, a total of four 3D models, two of Portland and two of Sinkentine, were created from video footage of 4k30 and 1080p60 resolutions. The still photographs of both resolutions for Portland were extracted at 2 fps, resulting in 3,370 photographs from the 4k30 footage and 3,475 photographs from the 1080p60 footage. The 4k30 Portland model achieved 98.5 percent alignment, while the 1080p60 model attained 57.6 percent alignment; thus, 98.5 and 57.6 percent of the photographs successfully overlapped with neighboring images, respectively. The lower alignment in the 1080p60 model is likely a result of the lower resolution used to capture footage of the wreck, causing the extrapolated still photographs to have fuzzy edges which the modeling software was unable to use during the alignment process.
resulting 1080p60 3D model only showed the forward one-third of the shipwreck, while the 4k30 3D model resulted in a complete model of the articulated portion of the Portland wreck.

In the PhotoScan software, the number of generated faces refers to the total number of created edges of mesh, which connects the points created in the “Dense Cloud” process. The Portland 4k30 model resulted in 12,875,184 faces, while the 1080p60 model contained 2,211,728 faces. The points at which the faces meet are referred to as vertices, which are created during the “Build Texture” step. The Portland 4k30 model resulted in 6,446,196 vertices, while the 1080p60 model contained 1,107,965 vertices.

Table 3. Portland 2 frames per second.

<table>
<thead>
<tr>
<th></th>
<th>Cameras (photos aligned)</th>
<th>Tie Points (# of points)</th>
<th>Dense Cloud (# of points)</th>
<th>3D Model (faces; vertices)</th>
<th>Orthomosaic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portland 4k30</td>
<td>3318/3370</td>
<td>332,298</td>
<td>64,375,958</td>
<td>12,875,184; 6,446,196</td>
<td>50,095x20,312 8.25 mm/pix</td>
</tr>
<tr>
<td>Portland 1080p60</td>
<td>2002/3475</td>
<td>193,282</td>
<td>11,058,712</td>
<td>2,211,728; 1,107,965</td>
<td>15,476x11,254 9.78 mm/pix</td>
</tr>
</tbody>
</table>

If the orthophoto of the Portland 1080p60 model (Figure 40) was the only image created from this project, it could be used for partial archaeological interpretation of the wrecking event and future management of the site. Since it is an accurate representation of the forward one-third of the shipwreck, the 1080p60 orthophoto provides a baseline for future changes to that portion of the wreck. It cannot, however, be used to monitor changes to the aft two-thirds of the shipwreck. Fortunately, the orthophoto extrapolated from the 4k30 model (See Figure 26) shows the entirety of the articulated shipwreck and is the more desirable image for archaeological interpretation. As such, the 4k30 orthophoto was the one selected to create a 2D site plan of Portland.
Figure 40. Orthophoto of *Portland* from 1080p60 resolution (K. Clevenger 2017).
After removing the heavily distorted aft portion of the 1080p60 model, the point clouds from the 1080p60 and 4k30 models were exported from PhotoScan as ASPRS LAS files (.las), a file format that is compatible with 3D point cloud data. The edited 1080p60 model contained 6,484,515 points, while the 4k30 model contained 50,627,827 points. These files were imported into CloudCompare, an open-source 3D point cloud processing software, and manually aligned atop one another to compare the overall differences of the two models (Figure 41). The features of the Portland models aligned, indicating that the 3D models created from two different video resolutions have the same scale and are not distorted. The achievement of only 57.6 percent photograph alignment in PhotoScan, however, made it evident that the 1080p60 model clearly lacked the aft two-thirds of the shipwreck.

The still photographs of both resolutions for Sinkentine were extracted at 1 fps, resulting in 481 still photographs from the 4k30 footage and 326 still photographs from the 1080p60 footage. The 4k30 Sinkentine model (Figure 42) achieved 63.8 percent alignment, while the 1080p60 model (Figure 43) attained 70.9 percent alignment. It is possible that the lower percentages of photo alignment are a result of the Sinkentine’s placement on a pool floor that slopes in a V-shape and resulted in shadows under the frames (Figure 44). Another possibility is the bright LED lights in the Minges Natatorium pointed directly at the water resulted in reflective areas in the video footage. The Sinkentine 4k30 model resulted in 1,726,596 faces and 865,961 vertices, while the 1080p60 model contained 252,287 faces and 126,826 vertices. In both 3D models of Sinkentine, tool marks and fasteners can be seen when the models are magnified.
Table 4. *Sinkentine* 1 frame per second.

<table>
<thead>
<tr>
<th></th>
<th>Cameras (photos aligned)</th>
<th>Tie Points (# of points)</th>
<th>Dense Cloud (# of points)</th>
<th>3D Model (faces; vertices)</th>
<th>Orthomosaic</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Sinkentine</em></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4k30</td>
<td>307/481</td>
<td>43,655</td>
<td>8,632,989</td>
<td>1,726,596; 865,961</td>
<td>12,702x11,778</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.966 mm/pix</td>
</tr>
<tr>
<td>1080p60</td>
<td>231/326</td>
<td>44,347</td>
<td>2,098,132</td>
<td>252,287; 126,826</td>
<td>4,620x4,361</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5.04 mm/pix</td>
</tr>
</tbody>
</table>

Figure 41. Point cloud analysis of the Portland 3D models using CloudCompare. The smaller yellow box marks the bounds of the 1080p60 model, while the larger one denotes the 4k30 model (K. Clevenger 2017).
Figure 42. Orthophoto of *Sinkentine* from 4k30 resolution (K. Clevenger 2017).

Figure 43. Orthophoto of *Sinkentine* from 1080p60 resolution (K. Clevenger 2017).
When comparing the 2 different video resolutions used for this project, the Portland 4k30 3D model achieved 40.9 percent higher alignment than the 1080p60 3D model. Sinkentine’s 1080p60 model attained 7.1 percent greater alignment than the 4k30 model. It is possible that the turbidity found in TBNMS made the higher resolution (4k30) video the better of the two resolutions tested for capturing video footage for photogrammetric purposes, and the clear pool water and bright lights made the 1080p60 video resolution a more accurate option for such an environment. More research in varying types of water, lighting, and turbidity is needed to determine which video resolution and frame rate speed is best for photogrammetry on shipwrecks.
4.2 *Comparison of Photogrammetry-based Site Plan to Standard Mapping-based Site Plan*

One of the main aims of this thesis was to extrapolate a 2D site plan of a shipwreck from a 3D model and resulting orthophoto. *Portland* was selected as a case study for this thesis not only because it was within reach of the OpenROV 2.8’s tether cable when deployed from shore, but also because a site plan that used standard mapping techniques already existed. In 2007, archaeologists recorded a portion of *Portland* to scale using standard mapping techniques over the course of several hours; the resulting site plan, however, was incomplete and lacked a scale (Wayne Lusardi 2016, elec. comm.). Nevertheless, it served as a comparative study to test the accuracy of the site plan extrapolated from the 3D model and orthophoto by comparing it to the portion of the shipwreck that was recorded using standard mapping techniques (Figure 45).

The most obvious difference between the two site plans is that the one extrapolated from the 3D model (Figure 45 A) contains the complete articulated portion of the shipwreck, while the site plan created from standard mapping techniques (Figure 45 B) is incomplete. Additionally, the site plan created in 2007 does not illustrate all fasteners present on the actual shipwreck. The site plan extrapolated from the orthophoto not only includes all fasteners, but the holes where fasteners previously existed (See Figure 39 for a larger image of the 2017 site plan). When the site plans are overlaid, the keelson structure, frames, and ceiling planking match in most places. Misalignment in some areas is likely a result of site formation processes that have occurred over the last 10 years or slight recorder error during the 2007 mapping session.
Figure 45. Comparison of Portland’s site plans created using different mapping techniques (A: photogrammetry, B: traditional mapping) (W. Lusardi 2007, figure 45b; K. Clevenger 2017, figure 45a).
4.3 Interpretation of Portland Site

With the assistance of Dr. Bradley Rodgers, an interpretation of the Portland site was conducted through an analysis of the unedited video footage, 4k30 3D model, the 2007 and 2017 2D site plans, historical charts showing depth contours at the time of wrecking, and satellite imagery showing the current location of the shipwreck and its relation to the shoreline. As stated in Chapter Two, there are two recorded explanations for the cause of Portland’s sinking. One newspaper account stated that the schooner was pushed ashore during a storm, while another claimed that the vessel was intentionally run aground to stop itself from sinking after springing a leak (Daily Globe 1877, Detroit Free Press 1877). Several attempts to free the schooner were made, but the vessel broke into several pieces before it could be released (Cleveland Herald 1877, Port Huron Daily Times 1877). As seen in the historical chart of Lake Huron published in 1880 (Figure 46), Portland wrecked in an area known to be less than 9.1 m (30 ft.) (5 fathoms) of water, causing the schooner – registering a 3.6 m (11.9 ft.) draft – to become lodged on the rocky bottom (Buffalo Daily Courier 1863). Since the keelson is nearly perpendicular to the shoreline with the bow facing away from shore (Figures 47 and 48), it is likely that the vessel ran aground during a storm and the crew had time to deploy grounding tackle. This resulted in the ship spinning around with the stern pointing towards shore and the bow facing outward into deeper water in an attempt to stop the vessel from running further aground (Appendix D). This interpretation indicates the crew was actively trying to save the ship, as was the case with numerous other vessel groundings including the ill-fated Lucerne (Cooper 1991:52-53).
Figure 46. Historical chart of Lake Huron from 1880 with the location of Portland illustrated by the red circle (K. Clevenger 2017, Base Image Courtesy of NOAA’s Office of Coast Survey).
Figure 47. The current location of *Portland* is visible on satellite imagery of the Besser Natural Area (K. Clevenger 2017, Base Image Courtesy of Google Earth).

Figure 48. *Portland* site plan overlaid on satellite imagery to illustrate the relation of the shipwreck to the shoreline (K. Clevenger 2017, Base Image Courtesy of Google Earth).

Due to the high level of detail found in the 3D model and 2D site plan of *Portland* (See Figures 26 and 39), it is possible to see the difference between nails and roved nails when analyzing
the fasteners. Wood grain can be established by consulting the video of the wreck, the extrapolated still photographs, and the 3D models, and phenotypical observations show the ship to be constructed of oak. Longitudinal support for the vessel was provided by the keel/keelson structure that contained a pair of sister keelsons and ran down the centerline of the ship, with the keelson being 35.6 cm (14 in.) sided and 30.5 cm (12 in.) molded. The schooner was built using double frame construction, with the larger frame partner forward of the smaller partner on the frames forward of the master couple and the larger frame partner aft of the smaller partner aft of the master couple. The frames are 10.2 to 12.7 cm (4 to 5 in.) sided and 15.2 cm to 20.3 cm (6 to 8 in.) molded, and lying on 2 foot centers. Molded dimensions were taken from the scaled 3D model rather than the site plan (Appendix D).

As the deck and deck beams loosened and broke, the sides of the vessel collapsed outwards, breaking at the turn of the bilge in typical shipwreck site formation fashion; this is evident in both the 3D model and 2D site plan. The starboard side of the schooner remains articulated and adjacent to the keelson and frames, but the port side has deteriorated and is scattered around the area. Rather than falling outboard with the majority of the starboard side, the starboard rail cap section collapsed inward, as evidenced by the rove caps noted on the outboard side of that section while the rest of the ship is nailed from the frames outward. Since the schooner was less than 45.7 m (150 ft.) in length, it should not have required a ceiling arch; there is not one in the archaeological data, nor is there evidence of iron strapping on the keelson. Certain scantlings, such as knees, are no longer extant on the articulated pieces of the shipwreck but are likely located in the surrounding disarticulated, scattered (and undocumented) pieces. With its plumb bow and original dimensions of 42.1 m (138 ft.) in length, 7.9 m (26 ft.) in beam, and 3.6 m (11.9 ft.) in depth, Portland could pass through the Great Lakes canal systems with
ease to deliver its cargo, making it a type known as a “Great Lakes Canaller” (Appendix D, *Buffalo Daily Courier* 1863).

The centerboard trunk with the partial remains of a centerboard is clearly visible in the section of the wreck containing the keelson, sister keelsons, and floors, and the master couple is seen approximately 1 m (3.3 ft.) aft of the pump hole. The port side pocket piece frames were pocketed below the trunk and are no longer articulated, as this was a relatively weak structural feature seen in numerous Great Lakes schooner shipwrecks. The keelson is predominantly intact and straddles the centerboard trunk rather than running to the starboard or port of it. The centerline trunk was in compliance with insurance company policy and is a clear indication that the schooner was constructed in 1850 or later. The multiple floors located on the starboard side aft of the centerboard trunk are indicative of a repair, likely completed in 1868 when *Portland* received a new keel, bottom, pocket pieces, and two heavy keelsons (Appendix D, *Chicago Tribune* 1868).

It seems likely that the shallow remains of *Portland* have been greatly affected by winter ice shove, a phenomenon seen when strong winds rapidly push free-floating lake ice onshore and resulting in massive and destructive ice piles (Rodgers and Green 1999). Changes to the shipwreck over the last decade can be seen by comparing the 2007 and 2017 site plans. Several sections of ceiling planking on the port side near the bow are no longer present, and some of the forward frames on the starboard side of the keelson have detached and floated away (Figures 49 and 50).
Figure 49. Zoomed in image of the 2007 Portland site plan illustrating ceiling planking and frames that were present at the time of recording (K. Clevenger 2017).

Figure 50. Zoomed in image of the 2017 Portland site plan illustrating missing ceiling planking and frames (K. Clevenger 2017).
4.4 Productivity Analysis

A productivity analysis of the entire archaeological process, which began with gathering field data and ended with extrapolating a site plan, was necessary to weigh the benefits of photogrammetry over standard mapping techniques. This analysis will only concern Portland, as Sinkentine was used only as a test site and a site plan was not created.

A total of two hours was spent in the field collecting data on Portland by one person, which included walking to the site, preparing the ROV for deployment, collecting two resolutions of video footage, packing equipment, and returning to the vehicle. The process of editing the 4k30 and 1080p60 raw video footage, extracting still photographs, and correcting lens distortion took a single person five active hours. Using the Toshiba Satellite S55t-B computer with 16 GB of RAM, the still photographs from the 4k30 video footage were aligned in PhotoScan over the span of 32 hours, and 282 hours were needed to generate the dense cloud. The researcher was not present for most of this process. Due to the amount of time taken to partially process the 4k30 model of Portland on the Toshiba computer, CSI’s Dell Precision T7910 computer with 128 GB of RAM was used to complete the project. CSI’s computer generated the 1080p60 and 4k30 3D models of Portland in a total of three days (72 hours) with the operator spending less than an hour actively working on the models. After the 3D models were completed, it took approximately 30 minutes to transform the orthophoto from Portland’s 4k30 model into a sketch conversion image. An additional 40 hours were spent by 1 person to extrapolate a site plan of Portland in Illustrator from the sketch conversion image, bringing the total time to 48 hours.

Using standard mapping techniques such as baseline offset, it is estimated that it would take 6 people with a moderate skill level a minimum of 10 days in the field to record Portland to
the same level of detail as the methodology presented in this research. Assuming that each person conducted 3 hours of diving per day for 10 days, it would take a 6 person team 180 hours to record Portland with standard mapping techniques. In order to determine time spent setting up a standard mapping-based project on Portland, drafting and inking a site plan, and analyzing the collected data, the estimated fieldwork time (180 hours) was multiplied by 4. This formula is typically used to determine total time needed for a project (Dr. Bradley Rodgers 2017, pers. comm.). The resulting 720 hours was added to the 180 hours spent in the field, bringing the total proposed project time to 900 hours. Naturally, increased depth increases the time needed to record a shipwreck. Thus, if Portland was located in 12.2 m (40 ft.) of water, it would require a minimum of 600 hours for a 6 person team to thoroughly record it using standard mapping techniques and 3,000 hours in total project time (Dr. Bradley Rodgers 2017, pers. comm.).

These estimates are further substantiated by consulting past Program in Maritime Studies field projects. In 1986, a team of 2 professional underwater archaeologists recorded Fleetwing, a predominantly articulated shipwreck of similar size and water depth as Portland, using baseline offset and trilateration mapping techniques with a total bottom time of 26 hours and 28 minutes (Cooper 1988:113). Obviously, the total bottom time refers only to that which divers spent underwater and does not include time spent conducting surface operations or preparing equipment, estimates for which were not included in the site report (Cooper 1988). In 2016, a team of 6 Program in Maritime Studies students, 1 faculty member, and 1 staff member returned to Fleetwing to record it again and conduct a site formation analysis of the changes incurred over the last 30 years. The 6 students conducted a minimum of 2 hours of diving for 12 days recording the wreck using baseline offset mapping techniques, resulting in a minimum total bottom time of 144 hours. The time difference in recording is a result of professionals noting
frame and fastener patterns, thereby allowing them to record faster (Dr. Bradley Rodgers 2017, pers. comm.).

In 1995, a team of five Program in Maritime Studies students and alumni volunteers and one Program staff member spent three weeks recording the shipwreck located at Claflin Point, Little Sturgeon Bay, Wisconsin. The wreck is located in 1.5 to 4.6 m (5 to 15 ft.) of water and is 51.8 m (170 ft.) in length and 6.7 m (22 ft.) in beam, which is approximately 9.1 m (30 ft.) longer than Portland. Diving from a 6.7 m (22 ft.) Boston Whaler, team members recorded the wreck using a scaled baseline and trilateration (Rodgers 1995). The total bottom time spent recording the wreck was not published; however, as it was a three-week project, it took significantly more time in the field to record it using standard mapping techniques than it did to record Portland with the customized OpenROV 2.8.

In total, 1 person spent approximately 48 hours actively collecting data in the field and completing Portland’s 3D models and 2D site plan; it is estimated that a 6 person team would spend a total of 900 hours recording the shipwreck in the field, completing a site plan of Portland using standard techniques, and conducting an analysis (Dr. Bradley Rodgers 2017, pers. comm.). Thus, it can be deduced that a photogrammetry-based project conducted in similar conditions to that of Portland is 1,875 percent more efficient than the standard mapping-based project referred to for this analysis.

4.5 Cost Analysis

In order to record Portland in 2016, a total of $2,700 was spent on the OpenROV 2.8, 3 GoPro cameras, spare batteries, fuel to reach the site, and post-processing software. Future projects using the photogrammetry-based mapping methodology would have very low overhead, as fuel is the only item listed above that is not reusable and would require additional expense. It
is estimated that $10,000, which would be spent on transportation, housing, SCUBA tank refills, daily stipend for each member of the team, and field and drafting equipment, would be required to record *Portland* using standard mapping techniques (Dr. Bradley Rodgers 2017, pers. comm.). For this project, the photogrammetry-based project was 73 percent more cost effective than the standard mapping project referred to for this analysis.

### 4.6 Conclusion

This chapter presented an analysis of 3D models created for this research and discussed the quality of data produced from the 4k30 and 1080p60 video resolutions and frame rate speeds. The photogrammetry-based site plan of *Portland* completed in 2017 was compared to the incomplete site plan created in 2007 using standard-mapping techniques. Furthermore, an interpretation of *Portland*’s wrecking event and subsequent site formation based on the completed 3D models and 2D site plan and an analysis of the site plan were conducted. A productivity analysis comparing a photogrammetry-based project to standard-mapping based projects concluded the chapter.
5 Discussion and Conclusion

Despite the limitations encountered during this research, the OpenROV 2.8 and GoPro cameras were successfully used to collect data sufficient for creating 3D models and 2D site plans of shipwrecks. While the limitations make the use of the OpenROV 2.8 impossible or impractical in some environments, this method is viable for recording shipwrecks located in water with current and surge less than 1.5 knots. Additionally, this method can be used in parts of the world where diving is logistically challenging. The knowledge gained from this research is useful for mitigating the calculated risks taken by underwater archaeologists when recording shipwrecks. This chapter examines the research conducted for this thesis and addresses the research questions. It concludes with a discussion of the significance of this study and suggestions for future research.

5.1 Answering the Research Questions

This thesis sought to develop a new methodology for recording shipwrecks using a small, low-cost ROV and action cameras with the end goal of producing a 1:1 scale constrained 3D model and 2D site plan. This study discussed the use of this method to assist in the management of shipwrecks, the advantages and limitations encountered, and various avenues of expanding public outreach. The following research questions were considered:

5.1.1 Can video footage of a shipwreck taken by low-cost action cameras attached to a low-cost, small remotely operated vehicle (ROV) be used to successfully create a photogrammetric image of a shipwreck that is accurate enough to allow archaeological interpretation?
After numerous alterations to the OpenROV 2.8 and experimentation with GoPro camera placement on the ROV, the unit was successfully used to gather data sufficient to create photogrammetric models of Portland and Sinkentine. While slightly distorted in some areas due to the flight path requiring narrower swaths, these 3D models are highly detailed. The Portland model created from 4k30 video footage allows clear visibility of the vessel’s fastener pattern and other construction details (See Figures 26 and 39). It is possible to conduct an analysis of the wrecking event and subsequent site formation processes from the 3D model, with an inappreciable loss of information over data collected with standard mapping techniques. The relation of the shipwreck to the shoreline indicates the crew had time to deploy grounding tackle in an effort to save the ship, which resulted in the bow facing away from shore, and indicates the crew was actively trying to stop the ship from wrecking. Additionally, by comparing the 3D models and subsequent 2017 site plan of Portland to the incomplete site plan made in 2007, it is possible to see site formation changes that have occurred, possibly due to environmental impacts.

5.1.2 Can this practice decrease the amount of time, workforce, and expense needed in the field to map a shipwreck?

A productivity and cost analysis comparing this methodology to standard mapping and post-processing techniques in terms of time, workforce, and expense was conducted using Portland as the analytical subject. In total, 1 person spent approximately 48 hours actively collecting data in the field and completing Portland’s 3D models and 2D site plan. It was estimated that a 6-person team would spend a total of 900 hours recording the shipwreck in the field and completing a site plan of Portland using standard techniques. Thus, the photogrammetry-based project proved to be 1,875 percent more efficient in terms of required labor. Furthermore, the photogrammetry-based project required a total of $2,700 to complete,
while it is estimated that $10,000 would be needed for a standard mapping-based project. As such, the former project was theoretically determined to be 73 percent more cost effective than the latter project. Thus, a photogrammetry-based project can significantly decrease the amount of time, workforce, and expense needed in the field to map a shipwreck.

5.1.3 **Is it possible to take detailed measurements of a shipwreck from the 3D model and/or 2D site plan?**

The ability to take detailed measurements from the products created during this research is an integral part of this methodology. The 3D models of *Portland* and *Sinkentine* were successfully scale constrained in PhotoScan using several measurements of features of the shipwreck taken in the field. Metric and imperial scale bars were created for the 2D site plan of *Portland*. From these scaled 3D models and 2D site plan, it is possible to take detailed measurements of any feature of the shipwreck. From the site plan of *Portland*, it was determined that longitudinal support for the vessel was provided by the keel/keelson structure that contained a pair of sister keelsons and ran down the centerline of the ship, with the keelson being 35.6 cm (14 in.) sided and 30.5 cm (12 in.) molded. The schooner was built using double frame construction, with the larger frame partner forward of the smaller partner on the frames forward of the master couple and the larger frame partner aft of the smaller partner aft of the master couple. The frames are 10.2 to 12.7 cm (4 to 5 in.) sided and 15.2 cm to 20.3 cm (6 to 8 in.) molded, and lying on 0.6 m (2 ft.) centers. Molded dimensions and wood grain were taken from the scaled 3D model and video footage of the shipwreck, thus illustrating the need to examine all the collected data in order to fully analyze the site. By using the original video footage of the shipwreck, 3D model, 2D site plan, bathymetry data, and the overall site plan with shoreline
data, it is possible to conduct a complete analysis of the Portland shipwreck and its wrecking event.

5.1.4 **Can this methodology assist in the future management of shipwrecks? If so, how can this data expand the public outreach component of management?**

Photogrammetry can aid in the prediction of future site formation processes by rapidly gathering baseline data and subsequent data over several seasons. By running 3D models from different field seasons through CloudCompare, changes to a site become readily apparent. Using the methodology developed in this thesis decreases time spent fully documenting each individual shipwreck and extends the field season into colder months, thereby allowing more shipwrecks to be examined in a field season.

Additionally, photogrammetric models have the ability to capture the public’s attention in a way that 2D site plans of shipwrecks cannot. Not only can virtual tours of the 3D models be created using Autodesk Maya software, but installation of interactive kiosks in museums can allow visitors to personally manipulate the 3D models and explore the shipwrecks digitally. This is especially useful for engaging people incapable of SCUBA diving. Model-sharing websites, such as Sketchfab, allow users to freely and quickly share the results of archaeological fieldwork with the public and colleagues. From Sketchfab, models can be further disseminated to social media websites, such as Facebook and Twitter, thereby reaching a larger audience.

5.1.5 **What are the advantages and limitations of this method? Are there options to mitigate the limitations?**

The advantages of this method include extending the field season and potentially recording more shipwrecks during a given period. The logistics needed to conduct shore dives differ from those required to conduct boat dives, with boat diving typically being the more time
consuming of the two methods. Due to the compact nature of the OpenROV 2.8 and minimal additional equipment needed for operation, the difference between deploying the ROV from shore or boat is negligible. Additionally, and unlike divers, the ROV is minimally effected by cold water; the only effect might be a decreased battery life, requiring batteries to be changed more frequently. Divers recording shipwrecks in cold water temperatures will require more time than those recording in warm water (Dr. Bradley Rodgers 2017, pers. comm.). In areas with sea conditions that are not possible for the small OpenROV 2.8 to navigate, divers have the advantage; however, it is probable that a larger ROV equipped with GoPro cameras placed in the same the locations and angles of the GoPro cameras on the OpenROV 2.8 can record in rougher sea conditions and faster current.

Numerous limitations of the OpenROV 2.8 were encountered throughout the data collection process. The small size and weight of the OpenROV 2.8 made it highly susceptible to surge and current, ultimately making its use impractical in such environments. The two knot top speed of the OpenROV 2.8 was decreased by the addition of three GoPro cameras, further decreasing its usability in areas with current. Additionally, the OpenROV 2.8 proved incapable of maneuvering in areas with aquatic weeds, as the tether quickly became entangled, and the ROV’s small motors were unable to clear the entanglement. The addition of small floats attached to the tether helped mitigate this problem. Shipwrecks with significant relief made piloting difficult, due to the higher risk of tether entanglement. The OpenROV 2.8 used for this research frequently experienced leaks in the battery tubes, which creates a potential for shorter battery lifespan, especially if the unit is used in saltwater. Ultimately, however, this method is useful for recording shipwrecks located in deep, cold, or contaminated waters and can be employed to minimize risks taken by divers.
In terms of photogrammetry limitations, it is not possible to use this methodology in areas with low visibility and high turbidity. PhotoScan is incapable of recognizing tie points in images captured in these conditions which makes it impossible for the software to align photos, resulting in incomplete 3D models. In low visibility or in waters with a large amount of particulate causing backscatter, divers will be more effective using standard mapping techniques rather than photogrammetry mapping techniques. Some 3D models might not contain enough detail to determine wood type and metal features, but this can be mitigated by a careful analysis of unedited video footage of the shipwreck. Additionally, this methodology cannot be used in shallow water, as it will not allow for the necessary images or footage to be captured. It is unlikely that photogrammetry on large objects, such as shipwrecks, can be used successfully in water less than five feet deep.

During post-processing, the only limitation encountered was the processing power of the computers used for PhotoScan. The Toshiba Satellite S55t-B laptop with 16 GB of RAM proved incapable of processing a model with 3,370 photos beyond the “Dense Cloud” step without experiencing a system crash. CSI’s Dell Precision T7910 computer with 128 GB of RAM, while capable of creating 3D models from greater than 3,000 photos, experienced significant lag time after the “Build Texture” step was complete, thereby causing more time to be spent cropping and orientating the 3D models before an orthophoto could be exported.

5.2 Significance of Study and Future Research

This research is the first known attempt to develop a methodology to record shipwrecks using a low-cost ROV equipped with attached action cameras. Additionally, it is the first to conduct a comparison of 4k30 versus 1080p60 video resolution for the purpose of creating a photogrammetric model. Further testing with 4k30 and 1080p60 video resolutions and frame rate
speeds is required, as the tests conducted for this thesis were inconclusive. From this research, however, highly detailed 3D models and 2D site plans of shipwrecks were produced and used for archaeological interpretation of the wrecks. The results of this thesis provide a methodology for recording shipwrecks that is less expensive and time consuming than traditional shipwreck recording methodology.

Several opportunities for future research presented themselves with the culmination of this study. The methodology for this thesis was developed on shallower wrecks to minimize the risk of losing the ROV while learning to pilot it; future research endeavors could include the use of this technology on deeper wrecks. OpenROV’s newest model, the “Trident” has the potential to overcome some of the limitations experienced with the OpenROV 2.8. With a more streamlined design and capability of reaching speeds of up to four knots, it will undoubtedly be less susceptible to surge and current. Camera placement on the Trident will need to be established; however, the knowledge of camera location and angles acquired during this research provides a useful foundation for future research with different ROVs.

5.3 Conclusion

This thesis presented the methodology of recording shipwrecks with a low-cost ROV with attached action cameras for the purpose of creating 1:1 scale constrained 3D models and 2D site plans of the study sites. The customization of an OpenROV 2.8 with GoPro action cameras allowed for video footage of shipwrecks to be captured. This was achieved through trial-and-error until the correct ROV flight path, speed, tether management, and camera placement was determined. Primary and secondary documents were consulted when selecting case studies for this research, and shipwrecks were selected due to their physical location and overall size. Ultimately, a complete 3D model of Portland was created using 4k30 video footage, and a 2D
site plan was extrapolated from the photogrammetric model. The combination of raw video footage of the shipwreck, 3D model, 2D site plan, bathymetry data, and the overall site plan with shoreline data allows for the complete analysis of the vessel and its wrecking event. This methodology provides a baseline for future research in the use of ROVs for recording shipwreck sites. As future endeavors bring advancements in ROV technology and photogrammetry, this methodology must be expanded or altered accordingly.
References Cited

Agisoft LLC

Anderson, Richard C.

Balletti, C., C. Beltrame, E. Costa, F. Guerra, and P. Vernier
2015  3D reconstruction of marble shipwreck cargoes based on underwater multi-image photogrammetry. *Digital Applications in Archaeology and Cultural Heritage*.

Bianco, G., A. Gallo, F. Bruno, M. Muzzupappa

Board of Lake Underwriters
1866  *The Inland Lloyd’s Vessel Register*. Matthews-Northrup Company, Buffalo, NY.
1881  *The Inland Lloyd’s Vessel Register*. Matthews-Northrup Company, Buffalo, NY.
1891  *The Inland Lloyd’s Vessel Register*. Matthews-Northrup Company, Buffalo, NY.
1901  *The Inland Lloyd’s Vessel Register*. Matthews-Northrup Company, Buffalo, NY.

*Buffalo Commercial Advertiser*
1867  *Buffalo Commercial Advertiser* 26 February. Buffalo, NY.

*Buffalo Daily Courier*
1863  *Buffalo Daily Courier* 28 October. Buffalo, NY.

*Buffalo Enquirer, The*
1891a  *The Buffalo Enquirer* 27 April. Buffalo, NY.
1891b  *The Buffalo Enquirer* 18 June. Buffalo, NY.

*Buffalo Evening Courier and Republic*
1862a  *Buffalo Evening Courier and Republic* 28 March. Buffalo, NY.
1862b  *Buffalo Evening Courier and Republic* 5 April. Buffalo, NY.
1862c  *Buffalo Evening Courier and Republic* 7 April. Buffalo, NY.

Buhr, Sarah
2013  OpenROV wants to get to the bottom of underwater mystery. *USA Today* 23 November. McLean, VA.
Bureau of Navigation
1872b Montana, Certificate of Enrollment, 8 July. Department of Commerce: Washington, DC.
1874 Montana, Certificate of Enrollment. Department of Commerce: Washington, DC.
1877 Montana, Certificate of Enrollment. Department of Commerce: Washington, DC.
1886 Montana, Certificate of Enrollment. Department of Commerce: Washington, DC.
1897 Montana, Certificate of Enrollment. Department of Commerce: Washington, DC.
1904 Montana, Certificate of Enrollment. Department of Commerce: Washington, DC.
1908a Montana, Certificate of Enrollment, 6 July. Department of Commerce: Washington, DC.
1908b Montana, Certificate of Enrollment, 8 July. Department of Commerce: Washington, DC.
1909a Montana, Certificate of Enrollment, 26 August. Department of Commerce: Washington, DC.
1909b Montana, Certificate of Enrollment, 1 November. Department of Commerce: Washington, DC.
1909c Montana, Certificate of Enrollment, 4 November. Department of Commerce: Washington, DC.
1910a Montana, Certificate of Enrollment, 9 March. Department of Commerce: Washington, DC.
1910b Montana, Certificate of Enrollment, 20 April. Department of Commerce: Washington, DC.
1910c Montana, Certificate of Enrollment, 14 October. Department of Commerce: Washington, DC.
1912 Montana, Certificate of Enrollment. Department of Commerce: Washington, DC.
1914a Montana, Certificate of Enrollment, 27 April. Department of Commerce: Washington, DC.
1914b Montana, Certificate of Enrollment, 12 September. Department of Commerce: Washington, DC.

Chicago Inter Ocean, The
1874 The Chicago Inter Ocean 25 December. Chicago, IL.
1906 The Chicago Inter Ocean 19 March. Chicago, IL.

Chicago Times
1862 Chicago Times 16 May. Chicago, IL.
1870 Chicago Times 7 June. Chicago, IL.

Chicago Tribune
1868 Chicago Tribune 17 July. Chicago, IL.
1870 Chicago Tribune 8 June. Chicago, IL.

Cleveland Herald
1877 Cleveland Herald 15 October. Cleveland, OH.

*Daily Globe*  
1877  *Daily Globe* 16 October. Ironwood, MI.

Demesticha, S., D. Skarlatos, and A. Neophytou  

*Detroit Free Press, The*  
1862  *The Detroit Free Press* 27 March. Detroit, MI.  
1868  *The Detroit Free Press* 1 April. Detroit, MI.  
1869  *The Detroit Free Press* 19 November. Detroit, MI.  
1877  *The Detroit Free Press* 16 October. Detroit, MI.  
1879  *The Detroit Free Press* 19 May. Detroit, MI.  
1895  *The Detroit Free Press* 27 September. Detroit, MI.

*Detroit Post & Tribune*  
1879  *Detroit Post & Tribune* 18 May. Detroit, MI.  
1879  *Detroit Post & Tribune* 19 May. Detroit, MI.

Diamanti, Eleni, Andreas Georgopoulos, and Fotini Vlachaki  

*Door County Advocate*  
1903  *Door County Advocate* 17 January. Sturgeon Bay, WI.  
1906  *Door County Advocate* 16 February. Sturgeon Bay, WI.  
1910  *Door County Advocate* 23 February. Sturgeon Bay, WI.  
1931  *Door County Advocate* 26 June. Sturgeon Bay, WI.

Dowling, Edward J.  

Drap, P. and P. Grussenmeyer  
Drap, P. and L. Long

Drap, Pierre, Julien Seinturier, Bilal Hijazi, Djamal Merad, Jean-Marc Boi, Bertrand Chemisky, Emmanuelle Seguin, and Luc Long


Goderich Signal
1868 Goderich Signal 27 August. Ontario, Canada.

2013 Mapping the Moon: Using a lightweight AUV to survey the site of the 17th century ship ‘La Lune’. OCEANS – Bergen, 2013 MTS/IEEE.

Green, J., S. Matthews, and T. Turanli

Green, Russell T., Catherine M. Green, and Dr. Bradley Rodgers

Hall, J. W.
1870 Marine Disasters on the Western Lakes during 1869. Marine Reporter, Detroit, MI.
1872 Marine Disasters on the Western Lakes during 1871. Marine Reporter, Detroit, MI.

Hartmeyer, Phil

Kiefer, Victoria, Tamara Thomsen, and Caitlin Zant

Kwasnitschka, Tom, Kevin Köser, Jan Sticklus, Marcel Rothenbeck, Tim Weiß, Emanuel Wenzlaff, Timm Schoening, Lars Triebe, Anja Steinführer, Colin Devey, and Jens Greinert
Lam, Brian

Lusardi, Wayne

Manistee Daily Advocate
1907 Manistee Daily Advocate 20 September. Manistee, MI.

Manitowoc Daily Herald
1906 Manitowoc Daily Herald 26 December. Manitowoc, WI.

McCarthy, John, and Jonathan Benjamin

Nornes, Stein M., Martin Ludvigsen, Øyvind Ødegård, and Asgeir J. Sørensen

OpenROV

Port Huron Daily Times
1877 Port Huron Daily Times 13 October. Port Huron, MI.

Port Huron Times
1870 Port Huron Times 5 June. Port Huron, MI.
1872a Port Huron Times 4 April. Port Huron, MI.
1872b Port Huron Times 20 June. Port Huron, MI.

Rodgers, Bradley A.
Rodgers, Bradley A. and Russell T. Green

Skarlatos, D., and M. Rova
2010 Photogrammetric approaches for the archaeological mapping of the Mazotos shipwreck. Paper presented at the 7th International Conference on Science and Technology in Archaeology and Conservation, Petra, Jordan.

Toronto Mail, The
1872 The Toronto Mail 23 November. Toronto, Canada.

Van Harpen, Jon Paul

Watts, Gordon P., Jr.

Westoby, M. J., J. Brasington, N. F. Glasser, M. J. Hambrey, and J. M. Reynolds

Yamafune, K., R. Torres, and F. Castro

Zant, Caitlin
Appendix A: Workflow for Shipwreck Reconstruction using Agisoft PhotoScan

Katherine Clevenger  
November 2016  
Version 1.2.6.2834

The following example portrays one possible workflow for reconstructing 3D models of shipwrecks using the PhotoScan software. It is recommended that the user downloads the Professional edition of PhotoScan, which includes the “scale constrain” feature that can be used to rapidly scale the completed 3D models. If the user is unable to purchase the software, 30 day trials can be downloaded from http://www.agisoft.com/downloads/installer/. Processing time will depend on the computer’s processor, installed memory (RAM), and operating system.

Add Photos: Workflow or Workspace
It is recommended that a new, well organized folder is created either on the computer’s hard drive or an external hard drive for each project. Images to be included in the 3D model are added to the project by clicking ‘Add Photos,’ located under the Workflow tab, or by clicking on the icon with the + symbol in the Workspace pane.
**Align Images: Workflow**

It is recommended that images are aligned with high accuracy, generic pair preselection, a key point limit of approximately 80,000, and a point limit of 1,000.

The number of aligned photos can be seen by opening Chunk 1 in the Workspace tab. Generic pair preselection allows the software to align photos much faster than when disabled. If the photo alignment is unsatisfactory, the user can align the images again with the pair preselection disabled, a slower but more accurate process.

The blue squares showing the location of the photos can be turned off by clicking the camera icon.
Build Dense Cloud: Workflow
The suggested parameters for building the dense point cloud of a shipwreck are medium quality and mild depth filtering.

Processing times increase rapidly for the high and ultrahigh quality settings, which are not necessary because the created meshes will connect the points. After the dense cloud is created, select ‘dense point cloud view.’ The bounding box can minimize the area around the object using the resize region icon. The rectangle, circle, and free-form selection icons and the delete and crop tools can be used to select and delete unwanted points.
Deleting these points at this stage will decrease the processing times for building the mesh and texture.

**Build Mesh: Workflow**

The suggested parameters for building the mesh are arbitrary surface type, dense cloud source data, high face count, and enabled interpolation.

Depending on the size of the dataset, a medium face count might be necessary to keep the number of faces and vertices at a reasonable number.
**Build Texture: Workflow**

It is recommended that the texture parameters are generic mapping mode, mosaic blending mode, and a texture size/count of 6000 x 3. Do not select ‘enable color correction.’ Select ‘enable hole filling.’

After the texture is complete, the 3D model can be cropped again, if necessary.

**Build Orthomosaic: Workflow**

This step is necessary if the user wishes to export an orthomosaic as a TIFF, JPG, or PNG file. It is recommended that the user set the 3D model to the view needed upon exporting. The suggested parameters are planar type, current view projection plane, and mosaic blending mode.
3D Model
Save the model as a PhotoScan Project first. ‘Export model’ allows the user to save as different file types. ‘Upload model’ allows the user to upload directly to other services, such as Sketchfab.
Appendix B: Workflow for Creating Models with XYZ Coordinates (Agisoft PhotoScan 2017)

Tutorial (Beginner level):
Orthomosaic and DEM Generation with Agisoft PhotoScan Pro 1.2 (with Ground Control Points)

Overview
Agisoft PhotoScan Professional allows to generate georeferenced dense point clouds, textured polygonal models, digital elevation models and orthomosaics from a set of overlapping images with the corresponding referencing information. This tutorial describes the main processing steps of DEM/Orthomosaic generation workflow for a set of images with the ground control points.

PhotoScan Preferences
Open PhotoScan Preferences dialog using corresponding command from the Tools menu:

Set the following values for the parameters on the General tab:
**Stereo Mode:** Anaglyph (use Hardware if your graphic card supports Quad Buffered Stereo) **Stereo Parallax:** 1.0

**Write log to file:** specify directory where Agisoft PhotoScan log will be stored (in case of contacting the software support team it could be required)

Set the parameters in the OpenCL tab as following: Check on any OpenCL devices detected by PhotoScan in the dialog and reduce the number of active CPU cores by one for each OpenCL device enabled. Set the following values for the parameters on the Advanced tab:

**Project compression level:** 6

**Keep depth maps:** enabled

**Store absolute image paths:** disabled

**Check for updates on program startup:** enabled

**Enable VBO support:** enabled

---

### Add Photos

To add photos select *Add Photos...* command from the *Workflow* menu or ![Add Photos](button) click *Add Photos* button located on *Workspace* toolbar.

In the *Add Photos* dialog browse the source folder and select files to be processed. Click *Open* button.

### Load Camera Positions

At this step coordinate system for the future model is set using camera positions.

*Note:* If camera positions are unknown this step could be skipped. The align photos procedure, however, will take more time in this case.

Open *Reference* pane using the corresponding command from the *View* menu.

Click ![Import](button) *Import* button on the *Reference* pane toolbar and select the file containing camera positions information in the *Open* dialog.

The easiest way is to load simple character-separated file (*.txt) that contains x- and y-coordinates and height for each camera position (camera orientation data, i.e. pitch, roll and yaw values, could also be imported, but the data is not obligatory to reference the model).

In the *Import CSV* dialog indicate the delimiter according to the structure of the file and select the row to start loading from. Note that # character indicates a commented line that is not counted while numbering the rows. Indicate for the program what parameter is specified in each column through setting correct column numbers in the *Columns* section of the dialog. Also, it is recommended to specify valid coordinate system in the corresponding field for the values used for camera centers data. Check your settings in the sample data field in *Import CSV* dialog.
Click OK button. The data will be loaded into the Reference pane. The Import EXIF button located on the Reference pane can also be used to load camera positions information if EXIF meta-data is available.

Then click on the Settings button in the Reference pane and in the Reference Settings dialog select corresponding coordinate system from the list, if you have not selected it in the Import CSV dialog yet. Set up Camera Accuracy in meters and degrees according to the measurement accuracy:
Ground Altitude should be specified in case of very oblique shooting. Click OK and camera positions will be marked in Model View using their geographic coordinates:
If you do not see anything in the Model view, even though valid camera coordinates have been imported, please check that Show Cameras button is pressed on the Toolbar. Then click Reset View button also located on the Toolbar.

**Check Camera Calibration**
Open Tools Menu → Camera Calibration window.

By default, PhotoScan estimates intrinsic camera parameters during the camera alignment and optimization steps based on the Initial values derived from EXIF. In case *pixel size* and *focal length* (both in mm) are missing in the image EXIF and therefore in the camera calibration window, they can be input manually prior to the processing according to the data derived from the camera and lens specifications.

If precalibrated camera is used, it is possible to load calibration data in one of the supported formats using Load button in the window. To prevent the precalibrated values from being adjusted by PhotoScan during processing, it is necessary to check on *Fix Calibration* flag.

PhotoScan can process the images taken by different cameras in the same project. In this case in the left frame of the *Camera Calibration* window multiple camera groups will appear, split by default according to the image resolution, focal length and pixel size. Calibration groups may also be split manually if it is necessary.

In case ultra-wide or fisheye angle lens is used, it is recommended to switch camera type from *Frame* (default) to *Fisheye* value prior to processing.
Align Photos

At this stage PhotoScan finds matching points between overlapping images, estimates camera position for each photo and builds sparse point cloud model. Select Align Photos command from the Workflow menu.
Set the following recommended values for the parameters in the Align Photos dialog:

- **Accuracy**: High (lower accuracy setting can be used to get rough camera positions in a shorter time)
- **Pair preselection**: Reference (in case camera positions are unknown Generic preselection mode should be used)
- **Constrain features by mask**: Disabled (Enabled in case any areas have been masked prior to processing)
- **Key point limit**: 40000
- **Tie point limit**: 10000

Click OK button to start photo alignment. In a short period of time (depends on the number of images in the project and their resolution) you will get sparse point cloud model shown in the Model view. Camera positions and orientations are indicated by blue rectangles in the view window:

**Place Markers**
Markers are used to optimize camera positions and orientation data, which allows for better model referencing results.

To generate accurately georeferenced orthomosaic at least 10 – 15 ground control points (GCPs) should be distributed evenly within the area of interest.

To be able to follow guided marker placement approach (which would be faster and easier), you need to reconstruct geometry first.

Select Build Mesh command from the Workflow menu and specify following parameters in the Build Mesh dialog:
Click OK button.

Then, when geometry is built (it usually takes a few seconds to reconstruct mesh based on the sparse point cloud), open a photo where a GCP is visible in Photo View by double-clicking on its icon on the Photos pane. Zoom in to locate the GCP on the photo and place a marker in the corresponding point of the image using Create Marker command from the photo context menu available on right-click on the opened photo in the corresponding position:
Select the marker on the *Reference* pane. Then filter images in *Photos* pane using the *Filter by Markers* option in the context menu available by right-clicking on the markers label in the *Workspace* pane.

Now you need to check the marker location on every related photo and refine its position if necessary to provide maximum accuracy. Open each photo where the created marker is visible. Zoom in and drag the marker to the correct location while holding left mouse button. Repeat the described step for every GCP.
Input Marker Coordinates

Finally, import marker coordinates from a file. Click Import button on the Reference pane toolbar and select file containing GCP coordinates data in the Open dialog. The easiest way is to load simple character-separated file (*.txt) that contain markers name, x-, y-coordinates and height.

In Import CSV dialog indicate the delimiter according to the structure of the file and select the row to start loading from. Note that # character indicates a commented line that is not counted while numbering the rows. Indicate for the program what parameter is specified in each column through setting correct column numbers in the Columns section of the dialog. Also, it is recommended to specify valid coordinate system in the corresponding field for the values used for camera center data.

Check your settings in the sample data field in Import CSV dialog:
Click OK button. The data will be loaded into the Reference pane.

**Optimize Camera Alignment**

To achieve higher accuracy in calculating camera external and internal parameters and to correct possible distortion (e.g. “bowl effect” etc.), optimization procedure should be run. This step is especially recommended if the ground control point coordinates are known almost precisely – within several centimeters’ accuracy (marker based optimization procedure).

Click the Settings button in the Reference pane and in the Reference Settings dialog select corresponding coordinate system from the list according to the GCP coordinates data.

Prior to optimization it is also possible to remove the points with the highest reprojection error values using corresponding criterion in Edit Menu → Gradual Selection dialog. Set the following values for the parameters in Measurement accuracy section and check that valid coordinate system is selected that corresponds to the system that was used to survey GCPs:

![Reference Settings dialog](image)

- **Marker accuracy**: 0.005 (specify value according to the measurement accuracy).
- **Scale bar accuracy**: 0.001
- **Projection accuracy**: 0.1
- **Tie point accuracy**: 4

Click OK button.
On the Reference pane uncheck all photos and check on the markers to be used in optimization procedure. The rest of the markers that are not taken into account can serve as validation points to evaluate the optimization results. It is recommended since camera coordinates are usually measured with considerably lower accuracy than GCPs, also it allows to exclude any possible outliers for camera positions caused by the onboard GPS device failures.

Click Optimize button on the Reference pane toolbar.

Select camera parameters you would like to optimize. Click OK button to start optimization process.

Set Bounding Box

Bounding Box is used to define the reconstruction area.

Bounding box is resizable and rotatable with the help of Resize Region and Rotate Region tools from the Toolbar.
**Important:** The red-colored side of the bounding box indicates the plane that would be treated as ground plane and has to be set under the model and parallel to the XY plane. This is important if mesh is to be built in Height Field mode, which is reasonable for aerial data processing workflow.

**Build Dense Point Cloud**

Based on the estimated camera positions the program calculates depth information for each camera to be combined into a single dense point cloud.

Select *Build Dense Cloud* command from the *Workflow* menu.

Set the following recommended values for the parameters in the *Build Dense Cloud* dialog:

**Quality:** *Medium* (higher quality takes quite a long time and demands more computational resources, lower quality can be used for fast processing)

**Depth filtering:** *Aggressive* (if the geometry of the scene to be reconstructed is complex with numerous small details or untextured surfaces, like roofs, it is recommended to set *Mild* depth filtering mode, for important features not to be sorted out)
Points from the dense cloud can be removed with the help of selection tools and *Delete/Crop* instruments located on the Toolbar.

**Build Mesh (optional: can be skipped if polygonal model is not required as a final result)**

After dense point cloud has been reconstructed it is possible to generate polygonal mesh model based on the dense cloud data.

Select Build Mesh command from the Workflow menu.

Set the following recommended values for the parameters in the Build Mesh dialog:

- **Surface type:** Height Field
- **Source data:** Dense cloud

---

116
**Polygon count:** *Medium* (maximum number of faces in the resulting model. The values indicated next to *High/Medium/Low* preset labels are based on the number of points in the dense cloud. Custom values could be used for more detailed surface reconstruction).

**Interpolation:** *Enabled*
Click *OK* button to start mesh reconstruction.

---

**Edit Geometry**

Sometimes it is necessary to edit geometry before building texture atlas and exporting the model.

Unwanted faces could be removed from the model. Firstly, you need to indicate the faces to be deleted using selection tools from the toolbar. Selected areas are highlighted with red color in the Model View. Then, to remove the selection use Delete Selection button on the Toolbar (or Del key) or use Crop Selection button on the Toolbar to remove all but selected faces.

If the overlap of the original images was not sufficient, it may be required to use *Close Holes* command from the *Tools* menu at geometry editing stage to produced holeless model. In *Close Holes* dialog select the size of the largest hole to be closed (in percentage of the total model size).

---

PhotoScan tends to produce 3D models with excessive geometry resolution. That's why it is recommended to decimate mesh before exporting it to a different editing tool to avoid performance
To decimate 3D model select Decimate Mesh... command from the Tools menu. In the Decimate Mesh dialog specify the target number of faces that should remain in the final model. For PDF export task or web-viewer upload it is recommended to downsize the number of faces to 100000-200000.

Click OK button to start mesh decimation procedure.

**Build Texture (optional; applicable only to polygonal models)**

This step is not really needed in the orthomosaic export workflow, but it might be necessary to inspect a textured model before exporting it or it might be helpful for precise marker placement.

Select Build Texture command from the Workflow menu.
Set the following recommended values for the parameters in the Build Texture dialog:

**Mapping mode**: Orthophoto

**Blending mode**: Mosaic

**Texture size/count**: 8192 (width & height of the texture atlas in pixels)

**Enable color correction**: disabled (the feature is useful for processing of data sets with extreme brightness variation, but for general case it could be left unchecked to save the processing time)

Click OK button to start texture generation.

**Build DEM**

Digital elevation model can be generated based on the dense cloud or mesh model. Usually first option is preferred, as it provides more accurate results (low-poly model, being used as a source data, may result in inaccurate DEM) and allows for faster processing, since mesh generation step can be skipped.

Select Build DEM command from the Workflow menu:
Coordinate system should be specified in accordance with the system used for the model referencing. At the export stage, it will be possible to project the results to a different geographical coordinate system.

After DEM generation process is finished, it is possible to open the reconstructed model in Ortho view by double-clicking on the DEM label in the Workspace pane:
Build Orthomosaic

Select *Build Orthomosaic* command from the Workflow menu:
Select desired surface for orthomosaic generation process: mesh or DEM, and blending mode.

Pixel size will be suggested according to the average ground sampling resolution of the original images. According to the surface size and the input pixel size the total size of the orthomosaic (in pixels) will be calculated and shown in the bottom of the dialog box.

Generated orthomosaic can be reviewed in Ortho mode similar to the digital elevation model. It can be opened in this view mode by double-clicking on the orthomosaic label in the Workspace pane.

**Export Orthomosaic**

Select *Export Orthomosaic → Export JPEG/TIFF/PNG* command from *File* menu.
Set the following recommended values for the parameters in the *Export Orthomosaic* dialog:

**Projection:** Desired coordinate system

**Pixel size:** desired export resolution (please note that for WGS84 coordinate system units should be specified in degrees. Use *Metres* button to specify the resolution in metres).

**Split in blocks:** 10000 x 10000 (if the exported area is large it is recommended to enable *Split in Blocks* feature, since the memory consumption is rather high at exporting stage)

**Region:** set the boundaries of the model's part that should be projected and presented as orthomosaic. Also, polygonal shapes drawn in the Ortho view and marked as boundaries will be taken into account for the orthomosaic export.

TIFF compression and JPEG quality should be specified according to the job requirements.
BigTIFF format allows to overcome the TIFF file size limit for the large orthomosaics, but it is not supported by some applications. Click Export... button and then specify target file name and select type of the exported file (e.g. GeoTIFF). Click Save button to start orthomosaic generation.

**Export DEM**

Select Export DEM → Export GeoTIFF/BIL/XYZ command from File menu.

Set the following recommended values for the parameters in the Export DEM dialog:

- **Projection:** Desired coordinate system
- **No-data value:** value for not visible points; should be specified according to the requirements of the post processing application.
- **Pixel size:** desired export resolution
- **Split in blocks:** 10000 x 10000 (if the exported area is large, it is recommended to enable Split in blocks feature, since the memory consumption is rather high at exporting stage)
**Region**: set the boundaries of the model's part that should be projected and presented as DEM. Also, polygonal shapes drawn in the Ortho view and marked as boundaries will be taken into account for the DEM export. Click *Export*... button and then specify target file name and select type of the exported file (e.g. GeoTIFF). Click *Save* button to start DEM generation.
### Appendix C: GoPro Hero 4 Black Camera Specifications

#### Still Image Resolutions

<table>
<thead>
<tr>
<th>Image Type</th>
<th>FOV</th>
<th>Width</th>
<th>Height</th>
<th>Aspect Ratio (Width:Height)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 MP</td>
<td>Wide</td>
<td>4000</td>
<td>3000</td>
<td>4:3</td>
</tr>
<tr>
<td>7 MP</td>
<td>Wide, Medium</td>
<td>3000</td>
<td>2250</td>
<td>4:3</td>
</tr>
<tr>
<td>5 MP</td>
<td>Medium</td>
<td>2560</td>
<td>1920</td>
<td>4:3</td>
</tr>
</tbody>
</table>

#### Video Resolutions

<table>
<thead>
<tr>
<th>Video Resolution</th>
<th>FPS</th>
<th>FOV</th>
<th>Width</th>
<th>Height</th>
<th>Aspect Ratio (Width:Height)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4K</td>
<td>30, 25, 24</td>
<td>Ultra Wide</td>
<td>3840</td>
<td>2160</td>
<td>16:9</td>
</tr>
<tr>
<td>4K Superview</td>
<td>24</td>
<td>Ultra Wide</td>
<td>3840</td>
<td>2160</td>
<td>16:9</td>
</tr>
<tr>
<td>2.7K</td>
<td>60, 50, 48, 30, 25, 24</td>
<td>Ultra Wide, Medium, Linear</td>
<td>2704</td>
<td>1520</td>
<td>16:9</td>
</tr>
<tr>
<td>2.7K Superview</td>
<td>30, 25</td>
<td>Ultra Wide</td>
<td>2704</td>
<td>1520</td>
<td>16:9</td>
</tr>
<tr>
<td>2.7K 4:3</td>
<td>30, 25</td>
<td>Ultra Wide</td>
<td>2704</td>
<td>2028</td>
<td>4:3</td>
</tr>
<tr>
<td>1440p</td>
<td>80, 60, 50, 48, 30, 25, 24</td>
<td>Ultra Wide</td>
<td>1920</td>
<td>1440</td>
<td>4:3</td>
</tr>
<tr>
<td>1080p</td>
<td>120, 90, 60, 50, 48, 30, 25, 24</td>
<td>Ultra Wide, Medium, Linear, Narrow*</td>
<td>1920</td>
<td>1080</td>
<td>16:9</td>
</tr>
<tr>
<td>1080p Superview</td>
<td>80, 60, 50, 48, 30, 25, 24</td>
<td>Ultra Wide</td>
<td>1920</td>
<td>1080</td>
<td>16:9</td>
</tr>
<tr>
<td>960p</td>
<td>120, 60, 50</td>
<td>Ultra Wide</td>
<td>1280</td>
<td>960</td>
<td>4:3</td>
</tr>
<tr>
<td>720p</td>
<td>240, 120, 60, 50, 30, 25</td>
<td>Ultra Wide, Medium, Narrow**</td>
<td>1280</td>
<td>720</td>
<td>16:9</td>
</tr>
<tr>
<td>720p Superview</td>
<td>120, 60, 50</td>
<td>Ultra Wide</td>
<td>1280</td>
<td>720</td>
<td>16:9</td>
</tr>
<tr>
<td>WVGA</td>
<td>240</td>
<td>Ultra Wide</td>
<td>848</td>
<td>480</td>
<td>16:9</td>
</tr>
</tbody>
</table>

*1080p120 and 1080p90 are available in Ultra Wide and Narrow FOVs only
**720p240 is available in Narrow FOV only
Overall great map, the detail is good enough to do a detailed analysis. I can even see the difference in fasteners between nails and roved nails. Wood grain might prove an issue on some unknown wrecks but not on this Great Lakes schooner that I am well familiar with. Even frame sizes on the double frames can be discerned with the larger frame partner forward of the smaller partner on the frames foreward of the master couple, and the larger frame partner aft of the smaller partner aft of the master couple.

The starboard side of the ship has fallen outboard as is the usual case in site formation when a ship splays out on the bottom after losing its deck and deck beams. The part of the starboard side that I thought at first glance to be a ceiling arch is not an arch but the rail cap section fallen into the hold. In other words, the very top of the starboard side has toppled into the ship and did not go outboard as the rest of the ship side did. This is easily discerned by seeing rove caps on the outboard side, while the rest of the ship is nailed from the frames outward. This is different than many Great Lakes ships, but there seems to be no convention on these fasteners, I have seen them both ways. There is no discernable ceiling arch on this vessel, meaning it was not needed, so the ship was likely less than 150 feet in length. With the plumb bow, I would guess that this ship was a Great Lakes Canal
er. Without measuring that would make the original dimensions 145 X 26.5 X 11 depth of hold.

The bottom of the ship is well displayed complete with centerboard truck and a centerboard located in the trunk. The master couple is easily seen just forward of the beginning of the trunk. The port side pocket piece frames are missing which is not surprising since they are pocketed below the trunk and represent a relatively weak structural feature. They are missing in a great many Great Lakes schooner wrecks I have seen. The keelson is intact for the most part and straddles the centerboard trunk instead of passing to the starboard or port of it. This indicates that the trunk is on the centerline of the ship as dictated by insurance company policy and indicates it was constructed in 1850 or later.

Frame Pairs are on 2 foot centers which is standard for many schooners of the time. The multiple floors located on the starboard side aft the centerboard trunk may indicate a repair and if they continued across the bottom would indicate the ship was converted to a steam barge possibly later in its career. These extra floors were necessary to hold the weight of boiler saddles and engines. Since they are not continuous in this case they likely indicate a repair.

Items needed for a more complete analysis:

Scale also in feet and inches, since these ships were built in feet and inches. This also makes instant tonnage conversions possible. My guess on this vessel is 500 - 585 tons.
The plan view needs to be accompanied or included in a bathymetric map. In a vessel grounding, bathymetry can allow for a quick view of the draft of the vessel as they run aground and stick on their draft.

An overall plan view of the site as it relates to the shore can literally double the information that can be gleaned from a site map. It can indicate if the vessel’s crew grounded intentionally, or if the vessel was out of control, or if the vessel grounded on a reef unexpectedly. An overall site map may also indicate if the vessel was accidentally stranded or if it ran aground in a storm and was able to deploy its grounding tackle so that the bow would be pointed away from shore.

There may be no iron on this ship but an indication of iron strapping or scantlings such as knees is always necessary. For instance, it is possible that this ship did not need a ceiling arch because there was iron strapping clamped to one or both sides of the keelson.

The afore mentioned wood grain on some miscellaneous parts.

**Conclusion:**
In all, and under good conditions, I would estimate that an analysis of this type 3d modeling would not result in an appreciable loss of information over archaeological technician drawn maps. If the original videos can be viewed in conjunction with viewing the model my guess is that it would be nearly as accurate, with the caveat of the previously mentioned items of scale, bathymetry, overall site plan with shoreline, and delineation of iron objects.